
 

 

 

 

 

 

 

 

 

 

 

 

 

User Guide 
Version 2.0 – November 2014 



Page P a g e  | 2 

Contents 

 

1. Welcome to your Xorro Workbook ............................................... 4 

1.1. Suggestions & Support ....................................................................................... 4 

1.2. System Requirements ......................................................................................... 4 

2. Quick “How to” guide ................................................................... 5 

2.1. Working with pages and files….. .......................................................................... 5 

2.2. Working with Objects on the Page ....................................................................... 6 

2.2.1 Move to other page: .................................................................................... 8 

3. Logo Index .................................................................................... 9 

4. Setting Up Workbook ................................................................. 10 

4.1. Installing Workbook .......................................................................................... 10 

4.2. Activating your copy of Xorro Workbook ............................................................ 13 

4.2.1 What is the customer key? ........................................................................ 13 

4.2.2 My computer doesn’t have internet connection ........................................... 13 

5. Workbook Layout ....................................................................... 15 

5.1. The Canvas ...................................................................................................... 16 

5.2. Canvas size (and orientation) ............................................................................ 16 

5.2.1 Changing the Page (or Canvas) size and / or orientation ............................. 16 

5.2.2 Page extend ............................................................................................. 17 

5.3. Working with Objects on the Canvas ................................................................. 17 

5.3.1 Working with Static Objects ....................................................................... 17 

5.3.2 Working with Active Objects ...................................................................... 22 

5.4. Viewing multimedia on the Canvas .................................................................... 22 

5.5. Placing a live Web Page  on the canvas ............................................................. 24 

5.6. Workbook folder explorer .................................................................................. 24 

6. Working with Pages in your Workbook ...................................... 26 

6.1. The Page Navigation Toolbar ............................................................................ 26 

6.2. Drag and drop items between pages ................................................................. 27 

6.3. Page Properties Menu ....................................................................................... 27 

6.3.1 Page Size – ............................................................................................... 28 

6.3.2 Background .............................................................................................. 28 

6.3.3 Grids ........................................................................................................ 29 

7. Menus and Views ........................................................................ 32 

7.1. The File menu .................................................................................................. 32 

7.2. The Edit menu ................................................................................................. 35 

7.3. The View menu ................................................................................................ 37 



Page P a g e  | 3 

7.4. The Insert menu .............................................................................................. 38 

7.5. The Tools menu ............................................................................................... 40 

7.6. The Help Menu ................................................................................................. 44 

8. Workbook Toolbars .................................................................... 46 

8.1. The Mode Select toolbar ................................................................................... 48 

8.2. The Property Select Toolbar .............................................................................. 51 

8.3. The Edit Toolbar............................................................................................... 53 

8.4. The Tools Toolbar ............................................................................................ 54 

8.5. Workbook’s Multi-User Mode (“MUM”) ............................................................... 58 

8.6. The Dynamic Tools Toolbar ............................................................................... 61 

8.7. The Geometry Toolbar ...................................................................................... 79 

9. Customisable Personal Toolbar .................................................. 81 

9.1. Adding to the personal toolbar .......................................................................... 82 

9.2. Creating Multiple Customisable Toolbars  ........................................................... 85 

9.2.1 Creating a new toolbar .............................................................................. 85 

9.2.2 Turning a customisable toolbar off – without deleting it ............................... 86 

9.2.3 Turning a customisable toolbar back on ...................................................... 86 

9.2.4 Deleting a customizable toolbar ................................................................. 87 

9.2.5 Exporting and importing toolbars ............................................................... 88 

10. Xorro Q Participation ............................................................... 89 

10.1. Xorro Q Web facilitator ............................................................................... 103 

11. Extra Workbook features ....................................................... 137 

11.1. Text conversion .......................................................................................... 137 

11.2. Ink into object as text ................................................................................. 137 

12. Administrators Guide ............................................................. 139 

12.1. About Workbook ......................................................................................... 139 

12.1.1 System Requirements .............................................................................. 139 

12.1.2 Default file locations ................................................................................ 139 

12.2. Deploying Workbook on a network .............................................................. 139 

12.2.1 Deploying workbook using group policy application deployment ................. 139 

12.2.2 Deploying Workbook in an image ............................................................. 140 

12.3. Customising Workbook ................................................................................ 140 

12.3.1 Applying customised settings to all users .................................................. 140 

12.4. Group Policy Settings .................................................................................. 140 

12.4.1 Templates .............................................................................................. 140 

12.4.2 Settings .................................................................................................. 141 

 



Page P a g e  | 4 

1.  Welcome to your Xorro Workbook 

Your Xorro Workbook provides an environment where you can easily draw, write, 
and type anywhere you like on the page, just as you’d expect on a whiteboard.   

Unlike a whiteboard however, you can create as many pages as you like in your 
Workbook, and move between these pages easily. You will be inserting images, flash 
objects, video, live web feeds, capturing screen shots from images or web pages, 
and customizing page backgrounds in just a few minutes. 

Once you have become accustomed to the basic functions of your Workbook, you 
will be ready to customise your own toolbars with your preferred pens, lines, shapes, 
links and shortcuts to frequently used tools.  Your custom tools will be available to 
you anywhere on your computer, not just within your Workbook! 

1.1. Suggestions & Support 

Your contributions to the future of this software are vital.  Any suggestions you might 
have to make the Xorro Workbook a more useful tool for educators and trainers are 
very welcome.  Please send your ideas to support@twotouch.com.  

1.2. System Requirements 

Processor: 800 MHz or greater 

RAM: 256MB 

Hard Drive Space: 40 MB 

Operating System: Windows XP (SP3), Vista (SP2), Windows 7, Windows 8  

Microsoft.Net Framework version 4 

mailto:support@twotouch.com
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2. Quick “How to” guide 

Following is a selection of some frequently asked questions (and answers).  If 
your query is not listed, please look it up in the Index. 

2.1. Working with pages and files….. 

How can I add a 
new page? 

At the top of the Page Sorter 
panel, click:  

 

Change Page 
Size 

Select the page in Page Sorter, or 
click on empty zone in current 
canvas, and then right click. Select 
the “Page Size” option. 

Adjust Size and Orientation of the 
page and click “OK” to save. 

 

How can I insert 
a grid? 

Select the page and right click. 
Select the “Grid” option.  This will 
place a grid into the background 
of the current page. 

Adjust the Grid settings and click 
“OK to save. 

How can I 
change the page 
background 
colour, or use an 
image as 
background? 

Select the page and right click. 
Select the “Background” option. 

From “Solid Colour” options, select 
the colour and click “OK”. 

To select an Image, click Browse; 
select the image and click “OK” 

How can I clone 
a page instantly? 

Select the page in Page Sorter and 
right click. Select “Clone Page”.  
The clone appears (currently 
selected) below the source page. 

How do I change 
Page Order? 

Select the page in Page Sorter, 
then drag it to desired order. 
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How can I easily 
import pages 
(from another 
Workbook) 

From “File” menu, select “Import 
Pages”.  Browse to the destination 
Workbook and select it.  A form 
appears displaying all of the pages 
in the selected Workbook.  Select 
those you wish to import, and 
press “Import Selected”. 

(You can also have two 
Workbooks open simultaneously; 
in one, copy a source page by 
right-clicking on that page ion 
Page Sorter; switch to the other 
Workbook and select the page in 
Page Sorter preceding the 
intended position of the import, 
then right click on the page in 
Page Sorter and select “Paste”.  
The source page is inserted at this 
location. 

 

How can I 
export pages, or 
the entire 
Workbook?  

From File menu, select “Export”.  
Select the pages to be exported, 
and the file format desired.  
Specify destination folder after 
pressing “OK”. 

 

How can I send 
the current file 
by email? 

From “File” menu, select “”Send To”.  You can choose between 
sending the file as an attachment via email as a Workbook, or 
sending it via email as a PDF. 

How do I 
“import” a 
Powerpoint 
slideshow / a 
SMART 
Notebook? 

Workbook natively opens Workbook files, SMART Notebook 
(*.notebook) files, Microsoft Powerpoint (*.ppt) files, and the 
common IWB file format.  Just press “File Open” and you should 
see all available files listed in the explorer window. 

How can I find 
lessons on line? 

Xorro-Ed is the relevant on-line sharing community for educators.  
From “File” menu, select “Find Lessons On Line”.  Your browser 
will open and take you to the Xorro Ed community site, 
http://resources.xorro.com.  

If you already are a Xorro-Ed member, login here (your login can 
be saved in Workbook under Tools>Options).  Otherwise, you will 
be directed to join (free) once you attempt to download a 
resource. 

2.2. Working with Objects on the Page 

How can I write It’s easiest to have several available pens set up in your Personal 

http://resources.xorro.com/
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on the page? Toolbar, and choose one of these.  You can temporarily change 
the properties of any such pen by right clicking it.   

How can I place 
text on the 
page? 

Just click on the canvas, and start typing.  Text will appear where 
you clicked.  The text is like other static objects: drag it wherever 
you like; the scaling and rotating handles make it instant and 
easy to size it as you wish. 

How can I 
convert ink to 
text? 

Select the ink you have written.  
Select the context menu from 
upper right corner.  First option 
should be “Select word”.  
Choose the closest conversion.  
You can remedy any errors by 
double clicking the result and 
typing. 

 

How can I insert 
a shape on the 
page? 

Insert from Insert menu, or have favourite shapes available from 
your Personal Toolbar for instant access.  Workbook offers 
squares (rectangles), circles (ellipses), equilateral and right angle 
triangles, pentagons, and custom polygons.  All can have default 
properties customised to your preference. 

How can I find 
image and/or 
video resources? 

Use Workbook’s Resource Finder (or select “insert from web” 
from Insert menu).  Finder performs a search of common web 
repositories using your keywords, to identify images and videos 
which are copyright and family filtered. 

How can I insert 
an image, video 
or Flash object ? 

Select Insert, then Image and then the image source. Images can 
be inserted from resources section. Similarly, individual images 
can be inserted within the Canvas.  

How do I modify 
any object on 
the canvas? 

“Dynamic” objects such as videos, web pages and Flash files, can 
be displayed or hidden, and can be sized and located on the 
canvas,  but they cannot otherwise be modified. 

   All “static” objects (ink writing or animations, text, lines, 
shapes, images) can be modified by selecting the 
object and clicking the control in upper right to reveal 
the context menu.  This menu will reveal a range of 
possible operations (cut, copy, clone, etc).   

In addition, on selecting any static object, the Properties Toolbar 
immediately displays available controls for that object type (fill, 
stroke, text properties, opacity).. 

How can I add 
or modify text 
labels to an 
object? 

Any object can have a text label applied to it, by double clicking 
on the object in the canvas.  A text editor appears into which you 
should type the label text. The text can be justified in this form as 
well. On clicking away from the object the text editor closes to 
reveal the label superimposed on the object.  Label position can 
be changed through the object’s context menu.  Label text 
properties are set on the properties toolbar when the object is 
selected. 

How do I switch 
on / switch off 

To enable “Infinite clone” for an object, click on the context menu 
(or right click the object) and select “Infinite Clone”.  This places 
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infinite cloning 
on an object? 

the object into infinite clone state, wherein any click on the object 
results in a clone being produced.  To exit this state and return to 
normal, select the object (either right click or drag-
select), and then click on the “infinite” symbol now 
evident at top right corner.  This will switch off the 
infinite clone state. 

How can I lock 
an object in 
place so it is not 
moved when 
touched? 

Right click on the object on the canvas (or select its context 
menu, upper right corner) , and select “Lock”.  Otherwise, select 
the object and on your keyboard select the shortcut, “Ctrl+K”.  
This locks the object in place, so that it can not 
be moved or modified.  To unlock it, select the 
object and click on the “locked” symbol now 
appearing at upper right corner.  

How can I 
connect objects 
and create a 
concept 
diagram? 

The Connector Line is a special class of line which is anchored in 
an object at each end.  This means that the line’s end moves 
when as the object is moved.  In addition, the connector line 
bestows a parent property to the origin object (the object from 
which the line is drawn), and a child property to the destination 
object (the object to which the connector line is drawn).  Using 
connector lines makes it quick and simple to draw associations 
between objects on your page, and hence create concept 
diagrams, mind maps and flow charts. 

Use the Connector Line tool to connect objects such as 
shapes, images, text etc) in relevant ways.  First select 
the tool  .  Next click within the boundaries of the origin 
object (ie the “Parent”), and drag (creating the connector line) to 
the destination object (th “child”).  Do not lift off the drag action 
until within the boundaries of the child object.  The two objects 
are now connected.   

Parent objects will display their parent status at 
upper left corner: Green if the child is visible, grey of 
hidden (or retracted). 

Export or 
instantly share, 
a drawing, other 
object or group 
of objects 

You may have created a sketch, or an assembly of ideas of some 
sort, and want to immediately share this to another document, or 
an email.  The easiest way is to select the object(s) and right click 
to ”Export Selection as Image.”  This creates a PNG file which can 
be inserted into any other context.  In most cases, you can also 
simply copy the selection and paste it into your intended 
destination; the end result is the same. 

 

2.2.1 Move to other page: 

Images can be moved to other pages. 

Press “Ctrl+L”, Right click on the image and select Link option. 

Images can be linked to Web Pages, Files on Computer, with other pages of 
Workbook or they can be saved as attachments.  
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3. Logo Index  
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4. Setting Up Workbook  

4.1. Installing Workbook 

Installing your copy of Xorro Workbook involves the following steps: 

 Click on the Workbook executable (.exe or .msi) file 

 You may encounter a security warning – select ‘run’ 

 You’ll then be given a choice of languages to install Workbook in.  

 You’ll be prompted to make sure that other programs operating on your 
computer are closed. Click ‘next’.  

 The license agreement will appear on the screen.  Once you’ve scrolled down the 
agreement (a failure to do so will halt you from continuing the installation) and 
agreed to the terms and conditions you will then be able to continue the 
installation. 
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 Workbook will ask you to select an install destination for Xorro Workbook.  By 
default, Workbook will install into the Program Files folder on your computer 
while all user-specific items are installed to the default User folder locations on 
your computer.  Once you’ve selected a folder (the default ‘Program Files’ is 
recommended) click ‘Install’. 

 

 Workbook will now install on your computer. Once that is completed you will be 
prompted to exit installation and asked if you want to ‘download the Xorro 
Workbook Resources’ and ‘Launch Xorro Workbook’ upon exiting. 

 

 If you select ‘download resources’ your internet browser will open up a ‘file 
download’ window and ask you if you wish to download ‘resources.exe’.  Click 
‘run’. Your computer will now download the workbook resource file which 
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contains a range of images as an aide for creating your Workbook.  The file is 
downloaded directly onto a Xorro folder on your C: drive.  
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4.2. Activating your copy of Xorro Workbook 

Once Workbook is installed and opened you’ll be prompted to “Activate workbook” 
within 30 days (see message below).   

 

The activation process depends on whether you have internet access or not.  If the 
computer you’re working on has access then click ‘next’. 

The next window will ask for your ‘customer key’ or to simply ‘continue the trial’. 

If you have your customer key then enter in your 16 digit customer key and click 
‘next’.  If you don’t, then select ‘continue the trial’ and click ‘next’.  

4.2.1 What is the customer key? 

The customer key is unique to your organisation.  Every organisation is provided with 
a customer key that all members can use (so long as adequate user licenses are 
purchased). If you don’t have the key contact your IT department or Xorro dealer. 

4.2.2 My computer doesn’t have internet connection 

If your computer doesn’t have internet connection head to the bottom of the initial 
pop up box and select ‘I don’t have internet connection’, click ‘next’.  

 

  



Page P a g e  | 14 

On the next screen you’ll be confronted with a website address and a range of text 
(box above). What you need to do is: 

 copy and paste the text from the box and the website URL. 

 save it into a text document. 

 transfer the document to a computer (via flash drive etc..) with net connection.  

 Once on a computer with an internet connection open the website. 

 Insert the text from the white box onto the site. 

 You will now receive a new activation code (this is your validation code) – copy 
and paste the code onto the text file and save it. 

Head back to your original computer (that needs workbook activation).  Open 
workbook and select ‘I don’t have internet connection’ and ‘I already have the offline 
validation code’. 

The next screen will prompt the user to enter in their ‘validation code’. Click ‘next’, 
the activation process will begin. 
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5. Workbook Layout 

To start your Workbook journey, you need to familiarize yourself with the layout. 

 

Canvas: 

The canvas is your main work area - detailed further in The Canvas section p.16. The 
canvas area may also be referred to as the ‘current page’.  

Page Sorter: 

 

A list of all the Pages within the Workbook file are shown as thumbnails to the side 
of the Workbook, in a panel called the ‘Page Sorter’.  The page thumbnail with a 
red outline denotes that this is the page currently displayed on the canvas.  

Toolbars: 

 

All of the controls needed to work around the Workbook are contained in Toolbars.  
There are seven toolbars (refer to section 8) which consist of grouped icons. The toolbars 
can be positioned anywhere around the edge of the Workbook window. 

You don’t have to use all of the toolbars!  Workbook’s powerful and simple Personal 
Toolbar lets you set up the toolbar containing just your favourite tools. 
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By default, toolbars are positioned at the top of the Workbook window, except for 
the ‘Page Navigation toolbar’ which is placed at the top of the Page Sorter. 

5.1. The Canvas 

The Canvas is your main working area. You should consider this as your whiteboard 
area, which you will use to draw, write, present, and share with groups of people. 

In no time at all, you will be able to: 

 Write in digital ink on the canvas; 

 put digital images or photos on your canvas; 

 capture onto your canvas, still ”snapshots” of work you are doing in other 
applications such as Excel or CAD packages; 

 insert videos, flash files, even live web pages, into your canvas. 

The real power of the Workbook comes from being able to integrate all of these 
different activities onto one surface, save it, and instantly share it with other people. 

Saving the Workbook allows you or others to return to it later and review it, or 
change it, or use it to launch other related activities. 

5.2. Canvas size (and orientation) 

You might have noticed by now, that by default the canvas is an A4 page in 
landscape view.  This makes it easy to see the whole canvas at once if you 
prefer (through Zoom under the View menu), and to print confidently 
knowing that what you have placed on the canvas is what will be printed! 

5.2.1 Changing the Page (or Canvas) size and / or orientation 

On the other hand, you might prefer to change this.  No problem!  Right click 
anywhere on the canvas (away from an object), to find the canvas context 
menu.  Otherwise, click on the down arrow in the upper right corner of the 
current page thumbnail in the Page sorter – this goes to the same place).  

Activity: Using the Canvas 
 

As your first activity, choose a pen from one of the toolbars and 
use this to write on the canvas.  Experiment with the effects of 
various tools: pens of different colours, styles, thicknesses; 
straight lines; erasers; shapes. 

 

Next, click on the arrow select button to return to mouse mode.  
In this mode, your touch means “mouse click”.  Drag your 
touch over an object or several objects to select them and 
move them.   
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Here you can change the size of the page (or canvas), its orientation, and 
apply backgrounds, grids or templates (see Page Properties Menu). 

5.2.2 Page extend  

At the bottom of the canvas is the ‘Extend Page’ option, once clicked it will 
add more space to the bottom of the canvas.  Bear in mind that since this 
changes the aspect (proportions) of the page, printing the page may not yield 
such reliable results as printing the default A4 page. 

5.3. Working with Objects on the Canvas  

Anything which you place on the canvas – ink, text, shapes, pictures, flash files, 
videos etc – can be manipulated in various ways depending on the type of object.  
There are two kinds of object:   

 “static” objects such as ink, text, shapes and images which do not change of 
their own accord, and  

 “active” objects such as multimedia, flash files and web views which can 
change while they are on the canvas. 

5.3.1 Working with Static Objects   

Static Objects, such as ink, text, shapes and images, can have a wide range of 
actions applied to them.  For further information about using the ink, line, and shapes tools refer to the 

mode select toolbar.   

Ink If you select Pen and start using it in the canvas, by default there blue ink, 

depth and impression of the ink can be manipulated and changed by clicking the 
Opacity button from the first row of Toolbar. To change ink colour on the extreme 
top left of the toolbar, you find the Stroke option. In the second row of the Toolbar 
you will also find options to select intensity and style of the stroke. Stroke width, 
Stroke style, Start Marker and End Markers are provided in the right side of the 
Stroke option.  

Lines and Connectors If you want to draw Line or use Connector, select the Line 

option from the first row of the toolbar. Lines can be drawn on the canvas and can 
be moved to any other are of the canvas by click and drag process. Similarly 
connectors can be used. While selecting a line or connector, it is possible to Edit 
Default settings by clicking the “Edit Defaults” option. 

 

 

Shapes If you want to work with the Shapes, you can select Shapes option from the 

first row of the toolbar. You can customize your shapes by changing the Fill options 
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and Stroke options. The width, Stroke style and stroke width can be changed as 
required. 

Text If you want text to start appearing in a particular location on the canvas, click 

on that location, and start typing. The text will appear in a text edit frame. When 
clicking away from this frame, the text will then be rendered as an object which can 
be scaled or rotated in the usual way.  Double clicking on this object will re-present 
the text in an edit frame.  You will be able to edit the text and adjust justification and 
wrapping within this text edit frame. 

Images To place an image on the canvas, choose Insert>>Image from the top 

menu.  Browse to the image location and select it.  The image will display on the 
canvas.  If the image is very large, you may need to scale it to make it fit on the 
page. 

Once a static object is selected (using the select tool) an outline will appear (fig 1.1) around 
it. 

 

Fig 1.1 - Static objects 1 

Three control “handles” are available on 
selecting any object on the Workbook 
page.  The top center (blue) handle 
rotates the object about its geometric 
center.  The red handle in the lower 
right corner permits the object to be 
easily scaled (enlarged or reduced).   

Clicking the arrow in the top right will 
reveal the ‘object menu’.  This can also 
be revealed by simply right-clicking on 
the object.  The object menu details the 
various actions which can be performed 
on the object: 

To change the size of the handles, refer 
to the ‘Options menu’ under the ‘Tools 
menu’. 

Object Menu (fig 1.2)  

This menu of actions will be available for any “static object” on the Workbook page, 
whether it’s a pen, a line, a shape or text.  

Fig 1.2 - Object menu 
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Clone – Will create a separate copy of the selected object. 

Fit to page – The object will increase in size to the largest it can be on the 

canvas.  

Export Selection to Image - allows you to take 

the selected object(s) and save it (them) as an 
individual image (PNG) outside of Workbook. 

 

Infinite clone - every time the object is touched a 

copy is created. To turn off, select the object, by 
using the select tool (refer to Mode Select toolbar) 
and dragging over the top, and clicking the infinite 
icon. 

 

Stack- Stack allows users to stack multiple objects 

on top of each other.  The user must first organise 
the objects that they would like stacked together 
from left to right on the canvas. Next, select all 
objects to be stacked, and select ‘stack’ from the 
menu.  The objects will be stacked above each 
other, with the upper-most being that object 
previously arranged furthest to the left of the page.   
To unstack the objects head back to the menu and 
select ‘UnStack’. 

Stack step through: Users can cycle through the 
different objects. 

Stack toggle: Users can choose between 2 
different ways of stacking; cascade and pile: 

 Cascade shows the main object and parts of 
the behind objects. 

 Pile shows just the object at the front.  

 

 

Collapse/uncollapse figures – Refer to Connectors in the Mode Select toolbar 

Flip left/right – Flips the object horizontally 

Flip up/down – Flips the object vertically 
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Order – Select where you want the object to sit on the page in relation to other 
objects (front or behind other objects). 

Label – Add a text label to the selected object. On 
selecting ‘Edit Text’, the ‘Edit Label’ window 
appears. The label may be positioned relative to the 
object.  ‘Enable text wrap’ keeps larger portions of 
text within the frame size of the object.  

 

Align – Align the text to either the left, right or center of the text position (chosen in 
the ‘label’ menu).   

Link - is a particularly helpful way of integrating access 
to resources from your canvas. Objects on your canvas 
can be linked to a variety of different sources all listed 
under ‘list type’.  When a link type is selected the ‘link 
location’ changes to suit. 

 ‘Web Page’ - Link the object to a specific web 
page.  Input the address into the ‘link location’ and 
then select the browser type.  If the ‘external 
browser’ is selected the link will open in the 
computers main browser.  If ‘internal browser’ is 
selected the link will open up within a workbook 
browser on the canvas (refer to the dynamics toolbar). 

 ‘File on this computer’ – Links to a file on your 
computer. Once ‘file on this computer’ is selected 
the ‘link location’ provides a ‘browse’ button that 
opens a browser from which users can search their 
computer for a file. Users can select if they wish to 
save the file directly to their attachments.  

 ‘Page in this Document’ – Link the selected object 
to another page within the current workbook.  
‘Link location’ provides the ability to select the 
destination page.  Select the page name (refer to 

working with pages section) from the window on the left 
hand side, or the ‘link pages’ position in page order 
(first, last) or position compared to the current 
workbook page (next, previous).  

 ‘Attachment’ – Once ‘attachment’ is selected a list 
of the attachments within the current workbook 
appears in the link location box.  Users select the 
attachment they wish to use.  

 ‘Link Method’ - The user can choose whether to 
launch the link via the ‘link icon’ positioned at the 
lower left corner of the object (see image below), or 
simply by clicking (or touching) the object itself.  
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 Remove link’ – Removes the hyperlink from the 
object. 

 

Add Sound allows the user to connect an object to a 
sound file (mp3 or wav). Upon selecting Add Sound a 
selection box will appear. You are given two ways of 
searching for a sound file: 

 File on this computer: By clicking ‘Browse’ 
Workbook will open up a standard search box that 
will allow you to search for sound files saved on 
your computer.  Select a sound file, click open (the 
files path will now appear in the box under File), 
and then ok. 

 Attachment: If you have previously attached a 
sound file to your Workbook page you can access 
it by selecting ‘attachment’ in the top box and 
then selecting the sound attachment you wish to 
use from the bottom box.  

Once you’ve attached a sound file, every time the 
object is clicked the attached sound will pause.  
Clicking it again will start playing the sound from the 
paused location. 

 

 

Lock - locks the selected object in place.  This 

prevents accidental dragging, re-sizing, or editing the 
object.  When object is locked, a red cross will be 
displayed at upper right corner. Click the red cross to 
disable locking.   

Dimensions –  Change the object’s size by editing a 

list of measurements. If you wish to keep the aspect 
ratio for the object tick the box next to ‘Lock Aspect’.  
Users can either, type in a size or use the up and down 
arrows to edit the measurements.  

 

Properties -  Provides access to any further options for manipulating the objects: 

fill colour, outline colour, line type, thickness, opacity, font type and size. In the case 
of images, this will be limited to adjusting the image’s opacity. For other objects refer to the 

properties select toolbar. 

Note: Breaking the locked aspect ratio of a shape created in Workbook 
(ellipse, rectangle, triangle, right angle triangle, diamond and pentagon) 

Upon creating a new shape you’ll find that its aspect ratio is locked by default (i.e. 
ellipses start off as circles, rectangles as squares).  To break the aspect ratio and 
enable the ability to re-shape an object with varying dimensions, select the object, 
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5.3.2 Working with Active Objects  

Active Objects, such as multimedia, flash files and web views, are displayed on the 
canvas in a frame with an orange header.  We call this frame, the ‘placeholder’. 

 

 

 

 

 

 

 

 

To move the object around the canvas, click or touch on the orange header bar and 
drag. 

Scaling the active object - To scale (or re-size) the active object, drag the red circle 
on the lower right of the object. 

Closing the active object - To close the active object push the ‘Close’ button at the 
top right corner.  This will completely close the object. 

Minimising the active object – Click the minimise button 
in the top left corner to minimise the active object.  This 
will replace the displayed object with a rectangular 
“placeholder”, labelled with the file’s name. 

To then re-launch the Active Object click on the 
placeholder. You can scale and move the placeholder just 
as you would any static object. 

Note: When the Active Object is directly engaged, it will occupy the focus 
of the screen.  Although ink can be drawn on the canvas, text cannot be 
typed and objects cannot be deleted.  To perform these actions, you need 
to either minimize or close the object. 

5.4. Viewing multimedia on the Canvas 

Video/ Audio files When a user engages a multimedia file (video, audio) on the 
Workbook canvas they’re given additional options within the frame.  

click on the red circle and drag directly up.  Although the shape will initially follow  its 
original aspect, dragging away from this will eventually break the aspect lock.  The 
“Lock Aspect” check box under the Dimensions menu adds  control over this feature. 

minimise 
close 

scale 
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 Play/Pause: Engage and freeze the multimedia file 

 Mute: Turn the sound on or off 

 Capture: Enables users to take snapshots of the playing video.  Once you 
clicked, an image of the last video frame is placed on the top left side of the 
canvas.  You can take as many captures as you wish.  

 Progress Bar: The red circle within the white bar indicates how far into the file 
you are.  By dragging the circle you can move further along, or back, in the 
multimedia file.  

 Annotate: Provides users with the ability to annotate over the top of their 
video. Once the annotate icon is engaged the video will stop and the user will be 
able to annotate over the top of the video, the annotate icon will also reappear 
as an eraser of which the user can erase annotations. The user can then take a 
screen shot of the annotations.  Once play is pressed the annotations will 
disappear and the video will continue.  
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5.5. Placing a live Web Page  on the canvas 

You can open a Web page by selecting Web Browser option from the first row of the 
Toolbar. A new web page within the canvas opens. Type in the URL you wish to 
open. The web page within the workbook can dragged to move around any area of 
the workbook.  You can select text or images from within the web page, and drag-
and-drop these to the Workbook canvas (Note: this does depend on the web site and 
how it has been constructed). 

 

5.6. Workbook folder explorer 

The Workbook Folder Explorer provides a convenient way to instantly access folders 
of resources located anywhere on your computer or network.  To experience the 
convenience for yourself, just open the folder, select the desired object (image, 
media etc), and drag it to the canvas to display it instantly.  

The Folder Explorer opens whenever you launch a folder link from Workbook toolbar 
or menu.  The Folder Explorer stays on top of the screen until closed.  

 

 

 

 

 

 

 

 

The left hand column features links to folders.  The folders are broken into two sets: 
‘Xorro’ and ‘Favourites’.  Under ‘Xorro’ is a range of folders created specifically for 
Workbook (activities), whilst under ‘favourites’ are folders previous linked to via the 
customizable personal toolbar (refer to customisable personal toolbar)  

accessible files Xorro/customisable folders 

New web page 

Web Browser  

close 
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Displayed within the main window is the file content of the accessible folders.  To 
place any of the files directly on to the Workbook canvas, double click on the file.  To 
close the browser, click the cross in the top right corner. 

 

 

 

 

 

 

To add a resource to a folder, use the ‘add folder’ button or right-click on an open 
space within the folder and select ‘add resources’  

  

Back  

Forward  

Back a level  Add a folder 
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6. Working with Pages in your Workbook  

Page Sorter All of the pages within the Workbook folder are displayed as thumbnails 
in the Page Sorter.  The page sorter can be located on either the left or right hand 
side of the canvas.  

6.1. The Page Navigation Toolbar 

The Page Navigation Toolbar, located above the page thumbnails, 
allows you to insert new blank pages at any time, or navigate 
between pages. 

 
New Page – Adds a new blank page to the page sorter after the 

currently selected page. 

 
Previous page – navigate back to the previous page. 

 
Next page – navigate forward to the next page. 

 
Switch – switches the page sorter bar to other side of the 

canvas. 

 
Close/Open Page Navigation – close and open the page 

sorter menu. 

 
View Attachments – list of attachments relating to the 

Workbook file. 

Once you’ve clicked on the View Attachments icon the page sorter 
is removed and a list of attachments, along with their file sizes, 
appears along the side of your Workbook page. 

Every time you place or create a video or audio file on your 
Workbook canvas it’s stored in the Attachments List (regardless of 
whether you delete the image or video from the canvas) and 
saved within the Workbook file. 

At any stage you can open up the list of attachments and drag out 
an attachment onto your workbook canvas. 

By right clicking on an attachment you’re given the opportunity to: 

Insert: Opens a computer search window from which you can 
select a new attachment and insert it into the Workbook file. 

Save as: Provides users with the ability to save the attachment 
outside of workbook. Ideal for live feed 
(refer to the ‘dynamic tools toolbar’). 
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Delete: Delete the attachment from your Workbook file. 

Please note that if you delete an attachment from the list, and it’s 
still an object on a page, then that object will fail to work. 

To exit out of the attachments list and return to the Page Sorter 
view, click on the toggle pages icon. 

6.2. Drag and drop items between pages 

You can also drag and drop items from the current page to another page’s 
thumbnail. 

Each page thumbnail in the Page Sorter is identified by a page number 
below it. Pages can be renamed by double clicking on the page name (or 
number) below the page thumbnail.  

6.3. Page Properties Menu 

Each page thumbnail in the Page Sorter features a button in its upper 
right corner.  Selecting this permits access to various page control 
commands: 

New Page – Adds a new page to the Workbook document  

Delete Page – Deletes the selected Workbook page  

Clone Page – Places a replica of the selected page into the page 
navigator.  

Copy Page - Takes a copy of the selected page for use with paste 

Paste Page – Places a copy of the copied workbook page into the page sorter 

Clear Page – Deletes all objects off the selected page 

Rename Page – Change the name of the page (name appears below thumbnail in 
page sorter).  

 

At the foot of the Page Properties menu are three Page Properties options: Page 
Size, Background, and Grid. 

Note: Another way of accessing the Page Properties functions is by right clicking on 
an empty portion of the canvas.   
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6.3.1 Page Size –  

The Page Size command permits you to determine the actual size (in millimeters) of 
the canvas on which you are working. By default, Workbook pages are set to A4 – 
landscape.  

Choose size from a pre-select, or customize the desired size.  Select either portrait or 
landscape presentation. You can set the selection to apply to all pages in the current 
Workbook. You may wish to make the selection your preferred default as well.   

 

 

 

 

 

 

Hint: If you make your canvas too large, you may find that larger images and other 
objects will slow down your computer’s processing of the canvas and performance 
will deteriorate. This would be especially noticeable when drawing ink over large 
images. 

6.3.2 Background  

You can change the background of any page, applying colours in the background, or 
selecting and applying an image to the background.   

Colour background –  

Select the circle next to ‘colour’.  Click on the Colour button below. Select the colour 
you would like for your background.  

Once you’ve selected your colour click ‘Ok’.  
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Image background –  

Select the circle next to ‘image’. Click the ‘browse’ button. A computer search 
window will now appear.  Use the window to search for an image saved on your 
computer.  Select the image you want to use, then click ‘open’.  

A preview of the background will now appear. 

 

 

 

 

 

 

 

 

Background style 

Below the preview window you’ll find a drop down menu of different background 
styles. Each style will place the image onto the background in a different way: 

Stretch – Image will be stretched to the corners on the page 

Top left – Will place the image (in its original size) into the top left of the background 

Centre – Will center the image (in its original size) into the center of the page 

Tile – Displays multiple copies of the picture as a tiled display.   

Stretched (Keep aspect ratio) – stretches the image without changing the aspect 
ratio. 

Once placed in the background, the image cannot be manipulated further, but can 
be removed from the background or replaced. 

Apply to all pages - Any background can be applied to 
the page in progress, or to all pages in the Workbook.  
Simply select the box next to ‘Apply to all pages’ and the 
background will be placed on all pages within the 
document.  

6.3.3 Grids 

Grids enable users to insert grids as background on to 

the Workbook canvas, and apply various snap-to and 
locking functions utilizing these grids. 

 

Select Grid Style 

Workbook offers  four grid styles that can be chosen for specific subjects.  These can 
be selected from the drop down menu at the top of the grid select window. 

Background style 

Preview window 



Page P a g e  | 30 

 Normal 

Places a grid comprised of squares 
onto the background of your 
Workbook.  

 

 Handwriting  

Places light and dark lines (similar 
to hand writing paper) onto the 
Workbook       canvas 

 

 Musical 

Places empty sheet music grids 
onto the Workbook canvas 

 

 Iso 45/45 

Applies a grid of 45 degree 
isometric dots to the canvas.  

 

 

 

Grid Size - Choose the size of grid desired (the lower the number the smaller the 
gap/size of grid lines/dots).  

Change the size by selecting plus or minus buttons from the grid selection 
window or entering a number in the box next to ‘grid size’. 

 Show Grid – Grid will appear on the background of the canvas.  

 Apply to all pages – Applies the grid to all pages in your workbook file.  

 Snapping to Grid:  The Snap functionality allows objects and images to be 
precisely positioned and aligned for design, presentation or overlay purposes.  

There are three Snap options available: 
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 Snap position – will “snap” objects to grid intersects as the objects are being 
moved over the canvas. 

 Snap resize – will “snap” object sizes as the objects are being resized. 

 Snap Lines – will “snap” lines to grid intersections as lines are drawn. 

Hint: Snap functionality can be, and often is, used with the grid not shown.  In this 
way (for example), lines can be drawn and easily made vertical or horizontal, and on 
pre-determined spacing. This is especially helpful for aligning objects and text either 
vertically or horizontally.  

 Highlight margins – Works for the ‘normal grid’ function.  Highlights  a 5*5 
square margin.   

 Template – Select ‘light’ or ‘dark’ options referring to the visibility of the selected 
grid. 
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7. Menus and Views 

There is a variety of menus located along the top of your Workbook screen.  Here is 
an explanation of how they work.  

7.1. The File menu 

Create a new Workbook, open an existing one, or save the currently open Workbook.  
If you choose “Save As”, you’ll be able to rename your currently open Workbook so 
that you do not overwrite the earlier version. 

 

File >> New opens a new Workbook document – this will close your current 
workbook file.  

File >> Open opens a previously created Workbook file – this will close your current 
workbook file.  

Also provides users with the ability to open a range of activities made in other 
interactive white boarding software.  

Import Notebook allows you to browse and select a file written in SMART Notebook 
software, and open it as a Xorro Workbook.  You will notice that all of the objects 
remain editable.  Some specific things to note: 

 Background templates will open as Background images.  

 Attachments may not always import correctly, or may import as attachments 
rather than as embedded objects.   

 Text may import without word wrapping, which may mean that you have to edit 
it to make it fit your desired layout. 

 Older SMART files with file extensions .xbk or .nbk, will need to be re-saved in a 
recent version of SMART Notebook to the current .notebook file extension, 
before they can be imported into the Xorro Workbook. 
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 Other file formats, such as Promethean Activboard’s Flipchart, can be imported 
into SMART Notebook using SMART import and then the resultant notebook file 
can be brought into Workbook.  

 You can also open SMART Notebook files directly through File >> Open 

Import PowerPoint 

 Browse your computer for a previously created PowerPoint file and open it within 
Workbook.  This provides you with the previously created PowerPoint file but 
within the feature rich Xorro Workbook.  

Import Common IWB 

 Provides users with the ability to open up an .iwb file within workbook.  .iwb files 
are a common file format devised for interactive whiteboard users.  

File >> Import Pages provides users with the ability to import a selected page from 
another Workbook file.  

Once selected a window will open and users can then search their computer or 
network for Workbook files that have pages they wish to import into the currently 
opened Workbook file. 

 

Once a Workbook is selected and ‘Open’ is clicked an ‘Import Pages’ window will 
appear.  Each page and attachment in the selected Workbook is displayed in the 
‘Import Pages’ along with a tick box.   

 

 

 

 

 

 

 

 

 

Each Workbook page that has their individual box ticked will be imported into the 
current Workbook file. The left hand side of the window displays the pages and 
attachments selected for import.   

Pages available to import 

Pages selected to import 

Import pages 
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Once pages have been selected and ready for importation, users click on ‘Import 
Selected’.  The selected Workbook pages will now be added to the currently open 
Workbook.  

File >> Recent Documents lists the last five opened Workbook files. Users can select 
a previous file and it will open – this will close your current workbook file.  

File >> Save saves changes to the current Workbook file.  It will also ask you if you 
want to ‘share the document’ if you have sharing switched on.  

File >> Share Provides Workbook users with the ability to save their Workbook file 
directly to the Workbook community website.  Once clicked the Workbook file will be 
saved – if the file hasn’t been saved before you’ll be required to go through the save 
process.  The Xorro Q login screen will then appear (see below). 

 

Enter in your community login – if you don’t have a login one click on ‘Not 
registered? Click here’.  Once you’re logged in then the ‘share window’ will appear 
and prompt you to enter in information regarding the category the Workbook 
document will fall under.  

 

 Title: Name of the Workbook document 

 Tags: enter in search tags that apply to the document (addition, cricket, Panada 
etc…) 
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 Categories:  Select the categories with which the Workbook falls under (can be 
more than 1) 

 Age range: Select the range of students that would benefit from the Workbook 

 Description:  A brief description of the Workbook 

 Instructions: Any specific instructions for using the Workbook document.  

Once you’re done adding information select ‘create resource’.  The resource will then 
be saved directly to the Workbook resource website.  

File >> Export allows you to export a page or the entire Workbook, as a series of 
images or a pdf.  There are three main steps involved.  

Choose if you want to export the document as a pdf file or an image. 

 Selects the pages you wish to export:  

 Current – current page being worked on,  

 All – the whole Workbook document,  

 Select – a range of selected pages are chosen and exported.   

 Save the document within a chosen file. For PDFs, select the location and name 
of the document.  For images choose a file to save in.  The document is saved 
using the Workbook file name.  

File >> Print prints the Workbook file.  

File >> Send to allows you to email the file as a Workbook file or PDF.   

File >> Exit closes the Workbook file. 

7.2. The Edit menu  

Basic functions and operations that can be undertaken on an object.  
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File >> Undo: Undoes your last action. 

File >> Redo: Reverses your undone action.  

File >> Clone: Makes a copy of a selected object. 

File >> Cut: Deletes a selected object from the canvas and makes it available to 
paste - you must select an object on the canvas first. 

File >> Copy: Copies the selected object(s) from the canvas and makes them 
available to paste – you must select an object on the canvas first. 

File >> Pate: Pastes copied objects onto the canvas. 

File >> Delete: Deletes a selected object from the canvas - you must select an 
object on the canvas first. 

File >> Collapse figures: Refer to connectors in the Mode select toolbar. 

File >> Un-Collapse figures: Refer to connectors in the Mode select toolbar. 

File >> Select All: Selects all objects on your current canvas - this will only work if 
you select the cursor (refer to the mode select toolbar section) first.  

File >> Clear Page: Wipes the current workbook canvas clear of all objects 

File >> Delete Page: Deletes the Workbook canvas you are working on - you must 
select the page you wish to delete from the page navigation bar (refer to the working with 

pages in your workbook section).   
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7.3. The View menu  

Change the appearance of your Workbook to better suit your work.  

 

View>>Zoom determines how large the page appears on your screen.  Use this in 
combination with Format>>Page Size, to control how large your objects are on the 
pages. 

 

View>>Toolbars determines which toolbars you want to have visible on the screen.  
A toolbar that has a tick next to its name indicates that the toolbar is turned on.  To 
turn a toolbar’s visibility off or on, highlight and click the desired toolbar.  

 

View>>Full Screen provides the user with the ability to enter into full screen mode 
(refer to the ‘tools toolbar’ section). 

  

User Hint:  Most users 
prefer to set Zoom to 
“Page Width” to maximise 
usable area.  
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7.4. The Insert menu  

Insert images, Flash items, video or audio, a new page, or an attachment into your 
Workbook.    

 

Insert>>Image provides the user with the ability to search for images from either 
their own computer or the Workbook web search tool and paste those images 
directly onto their current page.  

 

 From File: permits the user to browse to any location on their computer, 
network, select an image file, and import this image into the Workbook.  

 From Resources: Opens Workbook resource folder  

 From Web: Initiates the ‘Search for media’ feature (refer to ‘The dynamics tools toolbar’ 

section). 

Insert>>Flash permits you to browse to any location on your computer or network, 
select a Flash (swf) file, and import it as an active object.   

Insert>>Video / Audio permits you to elect a multimedia file, and import this onto 
the Workbook canvas.  Multimedia inserted onto the canvas in this way will display 
within the multimedia frame allowing you to pause, fast-forward, stop, rewind and 
play the object at will.  
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 Video from file: Search your computer for a video file 

 Video from web: Search for a video file using the Search for Media function 
(refer to ‘The dynamics tools toolbar’ section )  

 Video from live source: Opens up the live feed tool (refer to ‘The dynamics tools 

toolbar’ section) 

 Audio: Search your computer for an audio file  

Insert>>Web Page places a web form onto the canvas (refer to ‘The dynamics tools 

toolbar’ section) 

Insert>>New Page inserts a new page into your Workbook. 

Insert>>Attachment opens up a search folder from which you can search for files to 
attach to your attachment list. 

An Unused attachment widow will appear when saving or exiting a Workbook file.  If 
an attachment is inserted into the file, but not onto a page or attached to an object, 
then it will appear in the window.  If the user wishes to save the attachments then 
they ‘uncheck’ the tick box and click ‘OK’.  

The Format menu  

Supports functions such as layering and grouping of objects, which are also available 
from the Object select drop down menu in the Workbook. 

Format>>Page Size is where you can determine the actual size of your Workbook 
pages.  Choose between A4, A5, Letter, and a custom setting. 

Format>>Background allows the page background to be changed.  This is also 
accessible from the page menu and via a right click on the canvas. 

Format>>Group, Order, Link, Lock, Dimensions, Properties – Refer to ‘Workbook 
layout’. 
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7.5. The Tools menu 

Provides access to two specialist tools, each of which are also available via icons 
from the Tools toolbar. 

Tools>>Screen Annotate permits you to annotate over applications outside of 
Workbook (refer to the ‘Edit tools’ toolbar).  

Tools>>Screen Capture provides the ability to take a screenshot, inside or outside of 
Workbook, and copy an image back into your Workbook (refer to the ‘Edit tools’ toolbar). 

Tools>>Toolbars allows users to return toolbar settings to one of two factory 
defaults. 

 Reset to Defaults: Resets the toolbar’s positions to the factory default.  

 Customize Toolbars: Create/Delete a customizable toolbar (refer to the ‘customizable 

toolbar’ section). 

Tools>> Options provides users with a range of technical options.  Use the tabs 
along the top to switch between pages.  

Tools >> Options > Global 

General 

 Anti-alias: Reduces the jagged edges around objects created on the Workbook 
canvas.  Select “Yes” (turn on) or “No” (turn off) in the drop down menu. 
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 Icon Size: Users can adjust the size of the toolbar icons.  Three sizes are 
available: Small (classic Workbook size) Medium, and Large. To adjust, double 
click on the current Value and select the size from the drop down menu.  

 Default page size: Select the default size of all new pages created. To adjust, 
double click on the value and select the size from the drop down menu. Users 
select the page size (A4, A5, letter, or custom) and the page layout (portrait, 
landscape).   

 Default Browser page: Select the default browser page that first appears 
when using the Workbook web browser (refer to the ‘dynamics tools toolbar’) 

Autosave 

 Autosave interval: Refers to the time gap between autosaves  

 Turn on Autosave: turns the autosave feature on or off.  Turning off autosave 
(No) is useful when you don’t want the regular autosave function to slow down 
Workbooks performance; of course you then run the risk of losing new data 
should there be a malfunction during the session. 

Localization 

 Localization: Refers to the language Workbook menus will appear in.  

 

Tools >> Options > Figure 

General 

 Auto-rotate snap: When rotating an object it will ‘snap’ into place upon 
completion of every 90 degree turn. Select “Yes” (turn on) or “No” (turn off) in 
the drop down menu.  

 Auto-lock aspect ratio: Locks the aspect ratio for objects placed onto the 
canvas.  Select “Yes” (turn on) or “No” (turn off) in the drop down menu. To break 

the objects lock refer to working with ‘objects on the canvas section’. 



Page P a g e  | 42 

 Size of figure handle: Users can adjust the size of the handles that surround a 
selected object (refer to working with ‘objects on the canvas section’).  Users may wish to 
increase the size of the handles to make handles easier to use on an IWB.  

 Line smoothing: Increases line drawing performance 

 Stack display mode: Refers to the way objects are initially stacked when using 
the ‘object stacking tool’   (refer to working with ‘objects on the canvas section’). By selecting 
‘Pile’ the objects appear are stacked directly on top of each other and only the 
top object visible.  By selecting ‘cascade’ the objects are stacked on top of each 
other, with all objects visible.  

 Enable rotate gesture: Enable/disable the multi-touch rotate gesture. 

Connector 

 Turn on special connectors: Turns special connectors on or off. By turning on 
special connectors every time the user draws a connector line (refer to the ‘Mode select 

toolbar’) from the object and releases it over an ‘object free’ section of the canvas 
a new object will appear at the end of the connector.  That new object will be 
either: a replica of the parent object, or the last object selected using the 
Workbook toolbars (you can choose which option is preferred by adjusting 
‘special connectors mode’ – see below).   

 Special Connectors mode: Select the object that appears when using special 
connectors. If the user selects ‘selected from toolbar’ then the last object type 
selected from the toolbars (eg. A green square) will appear at the end of the 
connector as the child. If ‘from parent figure’ is selected, then a replica of the 
parent figure will appear.  

Tools >> Options > Search Tool 

General 

 Search in file system: Turn ‘on’ or ‘off’ the ability for tagged pictures, saved 
on the computer, to be searched for when using the ‘search for media’ tool (refer 

to the ‘dynamic tools toolbar’ section).  Once ‘yes’ is selected the ‘File System Search 
Location’ bar appears below. 

 Default download location: Determines the default location for images 
downloaded via the Search for Media tool (refer to the ‘dynamic tools toolbar’ section) 
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 File System Search Location: Select the file location for where searchable 
tagged images are to be stored on your computer. 

 Temporary Data: Deletes cache data saved from use of the search tool.   

 Activate safe search: Turns on or off the term filtering function used with the 
‘Search for media’ tool. 

 Enable YouTube: Determines if the Search for media tool (refer to the ‘dynamic tools 

toolbar’ section) provides media results from YouTube.  

 Custom words blacklist: The search media tool contains a bank of words that 
are on our search blacklist – won’t appear when you search for media files.  You 
can add your own words to the list through this option. 

Tools >> Options > Community 

Provides a range of options for linking your Workbook experience with the resources 
website (http://resources.xorro.com/home). 

General 

 Automatically login response system: If you have a Xorro Q account then 
by selecting ‘Yes’ it will automatically log you in.   

 Show community news on startup:  Displays the latest Workbook 
community news upon opening your Workbook document. 

 Are you a sharing person?:  If you select ‘Yes’ then Workbook will ask you if 
you want to share your Workbook file on the community website every time you 
save it. 

Xorro Community account information 

Enter your community details to save you from logging in each time you wish to 
connect with the resources website. Enter in your user name and password for the 
Xorro community and click ‘set’. 

  

http://resources.xorro.com/home
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7.6. The Help Menu  

Provides users with a range of support options 

Help>>User Manual opens up the Workbook user guide that is stored in Workbook.   

Help>>Support provides users with an email address to use if issues arrive.   

 Report Bugs – If you experience an issue then you can use ‘report bugs’ to 
submit a report of what happened directly to Workbook designers. Once ‘report 
bugs’ is selected a ‘Send a Bug Report’ window appears.  Simply enter in a 
description of the issue along with your email address (optional).  Once the form 
has been filled out the user clicks ‘submit’.   
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Help>>Workbook Community: Provides users with the ability to join the Workbook 
community. Once selected, the user will be presented with a form to fill out.  

Workbook community users will receive a monthly email detailing innovative ways to 
use Workbook.  

Help>>Download resources: Once selected Workbook will, begin to download a and 
save a range of clipart resources, for use within Workbook under the C:Drive. 

Help>>Check for updates: Lets users know if a new Workbook download is available 
and download a download link.  Check for updates require an internet connection.  

Help>>About provides users with information regarding the current version of 
Workbook being used, coding information and licensing agreement details.   
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8. Workbook Toolbars 

Your Workbook activities are managed using toolbars.  There are several toolbars, 
each of which can be turned off or on and placed around the perimeter of the 
Workbook window. 

 

 

 

 

 

 

 

 

 

 

Toolbar locations - These toolbars can be relocated to any part of the perimeter of 
your Workbook, by clicking on the dotted line at the left of the toolbar (the toolbar’s 
handle), dragging it to the selected location, then “dropping”.   Toolbars can only be 
placed around the perimeter of the canvas. 

 

Hiding and retrieving toolbars Any toolbar can be hidden from view through the 
View>>Toolbars function.  Just tick (show) or un-tick (hide) the relevant toolbars.   

 

User Hint:  Many educators prefer to position their toolbars 
at the bottom of the Workbook screen, so that they do not 
distract students or so that they can be more easily accessed 
by students at the IWB.  

personal toolbar 

edit toolbar mode select 
toolbar 

property select  

Geometry Dynamic tools Display tools 
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Workbook allows users to access the same functions through several different 
means, so users can safely customize their Workbook look-and-feel to suit their own 
preferences.   

If you don’t often use a toolbar, hide it!  This will remove clutter from the area which 
you are sharing with the group.  

As you become more comfortable with the Workbook, you’ll learn which tools you 
like to use most.  You would be well advised then to customize your own Personal 
Toolbar (refer to the ‘customizable toolbar’ section) with the exact lines, shapes, pens, links and 
resources, etc that you use day-to-day.  This will allow you to remove other toolbars 
and optimize your shared working area. 

Example of a Workbook Layout 

The following is an example of one user’s preferred Workbook space (see image, 

below): 

 

 The Properties toolbar is hidden from view (it is available automatically when the 
user indicates an object’s property is to be edited);  

 All toolbars are dragged to the foot of the working area; 

 The Personal toolbar has been modified to include preferred tools. 

 The Page Sorter at right, could also be retracted by pressing the Retract arrow 
above the page thumbnails.  

 Icons have been set to small (refer to the ‘format menu’ section) 
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8.1. The Mode Select toolbar  

 

 Select tool - provides users with the ability to control all objects, menus, 

and buttons on the workbook page.  Hold down and drag on the canvas to 
select objects.  

 Pan tool – use to ‘grab’ the canvas and scroll up and down. Double click 

to exit.  

 Lasso select – select objects on your canvas by dragging  

 Basic Pen function - provides users with the ability to annotate over 

the workbook canvas. Once clicked, the page properties menu opens. 

 Eraser/rubber function – Erase annotations and drawings from your 

canvas.  Once clicked the eraser menu will appear. 

Use the scroll bar to change the size of the eraser.  If you want to keep the 
chosen size select ‘Save as default’.  

Lasso Mode: Is a different way of erasing objects from the canvas.  Once 
you’ve selected it from the drop down menu, head to your canvas and 
begin to draw around a section of the canvas you would like objects 
deleted from.  You’ll notice a green line appear. 

Once you’ve finished creating your ‘erase area’ stop drawing and workbook 
will erase the objects within the area. 

 

 Text – Provides you with the ability to position the start point for typing 

text onto your canvas  

 Line – Create a line on the page (start point, end point, thickness, and 

colour are all editable). Simply click and drag. 

 Connector - Workbook’s in-built concept mapping function.   

Connector creates a line between two objects which is anchored at each 
end.  When one of the objects is moved the connector line moves and 
resizes, whilst the second object remains in the same place.  Connector 
enables both objects to remain connected regardless of movement.  To 
work connector the user clicks in the middle of the first (‘parent object’) 
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object and drags the connector line to the centre of the second (‘child 
object’) object.  Connector recognises the direction of the implied 
relationships between objects. Multiple objects can be joined to each other. 
The link line’s properties can be changed by selecting the line and using 
the properties select toolbar.  

You can also collapse objects in a parent to child fashion.  Access an 
objects properties (refer to ‘object menu’ section) and choose collapse figures or 
uncollapse figures. Also, all parent objects, when selected, have a green 
circle (expand/collapse control on the upper left of the selected object) on 
their selection outline.  Once clicked all the child objects connected to the 
parent object will collapse into the parent object. The circle will then go 
black.  To uncollapse click the black circle. 

 Shapes – Opens up a list of the predesigned shapes all available for use 

on the workbook canvas.  

 

Ellipse – Create ellipse (circle) shapes.  Simply click on the canvas and 
drag. 

 

Rectangle - Create rectangular shapes.  Simply click on the canvas and 
drag. 

 

Triangle – Create a triangle. Simply click on the canvas and drag. 

 

Right Angle Triangle – Create a right angle triangle. Simply click on the 
canvas and drag. 

 

Diamond – Create diamond shapes. Simply click on the canvas and drag. 

 

Pentagon – Create a pentagon. Simply click on the canvas and drag. 

 

Custom Polygon - The custom polygon tool allows you to create your 
own shapes.  To do this, select the icon, and click wherever you want the 
first corner (point).  Click again at the next intended corner, and the first 
edge will be drawn for you. 
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 Keep clicking to make as many corners as you want.  When you click 
again on your first point, the custom polygon will be “closed” and filled 
with the properties you selected. 

 Stamps – Opens up a range of usable stamps for your Workbook canvas. 

Simply select the stamp you wish to use and click on the canvas.   

 

Properties Preview Window - Immediately after selecting the pen, line or various 
shape creation icons the properties preview window will appear below.  

The object within the box is a preview of what the selected icon will look like 
when applied to the canvas (properties wise).  To change the properties click 
on the edit icon at the top of the preview box. This will activate the relevant 
properties in the Tool Edit menu. 

Once you’ve selected the properties that you wish to use you can add the object to 
your customizable toolbar by ticking the box next to ‘Add to Personal Toolbar’.  Then 
select ‘OK’ to begin using the object.  
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8.2. The Property Select Toolbar  

An interface for determining the properties of any object.   

 

 Stroke – Changes the colour of: pen, lines, shape outlines.  

 Fill – Changes the inside colour of a shape as well as the colour of text.  

 Fill Label – Changes the colour of any text that is placed within an object.  

 Stroke width (First line on left) – Alters the thickness of lines, and outlines 
of shapes. 

 Stroke style (Second line from the left) – Alters the style of lines, and 
outlines of shapes. 

 Start marker (third line from the left) – Alters the appearance of the start 
point for a line.  

 End marker (fourth line from the left) – Alters the appearance of the end 
point for a line (ideal for creating arrows). 

 Transparency – Alters the transparency of an object.  

 Font – Change the font style (font, colour, etc) of the selected text. 

 Font size – Alter the size of the selected font. 

 Bold – Makes the selected text bold. 

 Italic – Turns the selected text into italics. 

 Underline – Underlines the selected text. 

 Strikethrough – Puts a strikethrough line through the selected text. 
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Selecting colour – Upon selecting Fill, Fill label, or Stroke you’ll be given the 
opportunity to select a colour from a drop down menu of 40.  If you wish to select a 
different colour click ‘more’ and you’ll be provided with a colour wheel (see below).  

Using the colour wheel users select their desired colour. If you wish to make the 
colour darker or lighter then use the ‘Lightness’ slider on the right.   

Once you have the colour you want you can save it to your custom colour list by 
selecting a save position (bottom left) and clicking save, or, you can simply click ‘OK’ 
to apply the colour to the current or future object.   

The available properties will differ depending on the type of tool selected.  Once 
properties have been set for a tool, these will be “remembered” for the next time 
that tool is selected from the Mode Select Toolbar. 

The Properties Toolbar can also be used to edit the properties of any object selected 
on the Workbook page.  It can be accessed by right clicking (or selecting the Context 
menu of) the object on the canvas, and selecting “Properties”. 
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8.3. The Edit Toolbar 

 

 
Open a new Workbook file 

 
Open an existing Workbook file 

 
Save the current Workbook file 

          

  

Undo your last action 

          

 

Redo undone action 

           

  Cut selected object(s) from the page 

          

 

Copy selected object(s) 

         

 

Paste copied/cut objects 

 
Delete selected object 
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8.4. The Tools Toolbar 

 

          

 

 

 

 

                                                                                                     

Screen Annotate – Screen annotate provides users with the ability to 

annotate over any program outside of Workbook. When launching 
Annotate mode, the Workbook is hidden and you will be returned to 
your desktop (or whatever other window(s) is open and maximised). 

The Screen Annotate toolbar will appear along with your custom toolbar 
functions (refer to the ‘dynamic tools’ toolbar section):  

 

 

 

 

 

 

 

 

Users can navigate around their computer by using the mouse mode 
(mouse icon). Once a tool from the toolbar is selected a transparent 
layer covers the screen so that users can annotate over the top of the 
application. 

The Screen Annotate toolbar will provide you with a range of options 
from Workbook which you can employ at any time.  You can add to the 
range of tools available to you by clicking on Tools and selecting either 
one (or both) of the available extra toolbars. 

 

You can choose to add the Property select toolbar, the mode select 
toolbar or the Maths tools.  

Users can manipulate annotations by using the ‘select’ icon (refer to the 

‘mode select toolbar’ section) from the custom toolbar; this will allow them to 

mouse mode undo 

Import area import page 

cursor 

customisable toolbar 
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manipulate objects on the transparency, eg size etc..   

To save an annotation, users can “capture” a screen shot of it.  This 
screenshot is sent back to a Workbook page. 

There are two screen capture options: 

Import area as Image: Allows users to select a rectangular area to 
capture.  Simply click and drag across the area you wish to capture, a 
dotted box will begin to form around the area of the capture square. 

Import screen as Page: Takes a snapshot of the whole screen and 
imports it back into your Workbook. 

Moving on to a new screen: Once users have annotated (eg drawn 
ink) onto the screen, they can then select the mouse icon to access the 
window “under” the transparency and start a new annotation.  This 
action will result in the current annotation being exited.   

If the previous annotation was captured then screen annotate will enter 
into mouse mode instantly.  But, if the annotation was not captured then 
the user will be asked if they wish to continue or not.   

If the user selects ‘Yes’ then screen annotate will revert back to mouse 
mode control.  If the user selects ‘No’ then screen annotate will resume 
on the same annotation, allowing the user to save it before exiting.   

To return to Workbook, close the Annotation toolbar using the close 
button on the top right corner of the toolbar. Again, if users haven’t 
captured their annotation they will be confronted with the window 
asking if they wish to continue.  If they click ‘Yes’ screen annotate will 
be exited and Workbook re-launched.  

           

 

 

 

 

                                                                                                               

Screen capture – allows you to take snapshots of parts or all of your 

computer screen, automatically saving them to your Workbook file.  
Once screen capture is clicked it will launch the screen capture menu.  

You will still have full control over your computer, enabling you to 
choose which windows you want to capture.   There are three ways of 
capturing snapshots: 

Capture Rectangular Area: click and drag across a specific area you 
wish to capture. 
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Capture Full Screen: Captures the complete screen 

Capture Window: Captures just a single program window (e.g. just 
word, just the picture file) 

The Snapshot Tools can be used within or outside of the Workbook, to 
select an area or Window, and “capture” a screen shot of this into the 
current Workbook page 

All screen captures are sent directly onto your current workbook page - 
unless you tick the box next to Insert Into A New Page on the screen 
capture menu, this results in every screen capture appearing on a new 
page.  

To exit screen capture click on the exit button on the top left hand 
corner of the screen capture menu.  

          

 

 

 

 

                                                                                                       

Full Screen mode – Gives you the opportunity to turn your workbook 

into an editable slideshow, maximizing the canvas and eliminating 
excess menus.  Once clicked, al l toolbars, page navigation menus and 
page menus will disappear and the canvas will now take up the whole 
screen.   

In the top left hand corner the full screen mode toolbar will pop up. 

The menu contains page navigation tools and five toolbar buttons that 
open up distinct toolbars containing various tools for interacting with 
your page.  

To access a toolbar simply click on the icon and a menu of tools will 
drop below. 

Personal Toolbar: 

The personal toolbar’s tools reflect the tools in your personal toolbar 
(refer to the ‘customizable toolbar’ section).  

Edit Tools: 

The Edit tools toolbar contains all the tools from the Edit toolbar (refer to 

new page 

previous page next  page 
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the ‘file menu’ section).  

Drawing Tools: 

The drawing tools toolbar contains tools from the Mode select toolbar 
(refer to the ‘Mode select’ toolbar section).  

Property Tools: 

Contains a variety of tools from the rich text box and the property select 
toolbar.  

 

Internal Tools:  

Contains a range of tools from the Tools toolbar, Geometry toolbar,  and 
Dynamic Tools toolbar. 

To close a toolbar click on the icon again. 

To exit Full Screen Mode and return to normal view, click on the cross 
button on the top right hand corner.  
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8.5. Workbook’s Multi-User Mode 
(“MUM”) 

If your computer is running Windows 7, and is connected to a Xorro 
2150 model IWB, you will be able to enjoy Workbook’s Multi User Mode 
(“MUM”). 

MultiUser Mode (“MUM”) provides a collaborative arena 
in which two users can simultaneously interact with 
items on the Workbook canvas, annotate or draw, and 
type text separately.   

MUM supports multi-touch gestures, allowing 
users to scale items on the canvas using “pinch” 
gestures (bringing two touches on the object 
closer or further apart.  Items can be rotated by 
placing one touch on the object to determine the 
centre of rotation, and then dragging with 
another touch on the object in the direction of rotation. 

To start, consider a simple Workbook canvas with several images and 
several text objects, as at below left.  Pressing the Multi User icon 
transforms this canvas into the Multi User Mode (shown below, at right). 

 

In Multi User Mode, The canvas is recreated in a “shared zone” shaded 
blue, below which are two separate user zones (shaded white).  The two 
users each have their own individual canvas into which they can drag 
the elements from the shared zone.  Elements can include text, 
drawings, shapes, images, and even multimedia items such as video or 
audio. 

 

 

In addition, a simple toolbar allows each user to perform basic tasks 
independently of the other user. 
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Pressing the Text button in the user toolbar invokes a personal keyboard 
which can be used to type a text string into that user’s canvas.  The text 
strings can be moved and resized, and also placed into the shared zone.  

Note that the keyboard types one string; to type another text string, the 
Text button must be pressed twice, to close and re-start the keyboard.   

To annotate, press the arrow button to convert it into a pen.   

The colour of the pen can be changed by pressing the coloured circle to 

the right of the pen button, and dragging upwards to expose the colour 
wheel.  Then continue the drag to select the desired colour for the pen. 

Each user can select items (ink, text, images, videos etc) from the 
Shared zone above (shaded blue), and drag these into the user’s canvas.  
Users can use multi-touch gestures to scale and rotate the items.  Users 
can then add ink and type text onto their canvas.  Items from the user’s 
canvas can be dragged to the shared zone. 

The two users can work in different colours (eg red and blue, below), or 
can also be performing different activities (for example, one annotating 
or drawing while another is typing text).  

 
When the Multi User activity is over, Multi User Mode is closed by 
pressing the Exit button (between the two user zones).  This will restore 
the single user Workbook canvas, preserving the individual user 
contributions on this. 
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 Magnifier provides users with the ability magnify portions of their 

screen.  Clicking the magnifier icon will engage the magnifier.  

 

To move the magnifier, click and drag on any part of the magnifier’s 
square and navigate it around the screen.   

 

 

 

 

 

 

 

 

 

 

 

 

 

Close Magnifier: Right click on the Magnifying window.  

 Spotlight - is a tool designed to highlight one specific area of the 

screen.  Once a user clicks on the spotlight icon the screen goes black, 
apart from one square patch (the spotlight viewer) which exposes the 
Workbook canvas behind it. 
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Note:  You will still be able to edit and move objects that are inside of 
the spotlight square. 

 

To move the spotlight viewer around the page, place the cursor on a 
blacked out area.  Now, move the cursor in the direction you wish the 
spotlight square to move. Continue to move the cursor in the direction 
you wish the tool to go.  

 

Note: The movement of the spotlight square may take some getting use 
to – but it does allow you to control the square from anywhere on the 
screen (making life easier for interactive whiteboards). 

 

To adjust the size of the ‘Spotlight viewer’ move the cursor to the edge 
of the viewer’s frame. The cursor will now change its appearance to 
resemble an arrow with an arrow head on each side.  

 

By right clicking on the blacked out area of the screen users can engage 
the Spotlight menu.  

 

Opacity:  Choose the transparency level of the ‘blacked out’ background 
colour that surrounds the spotlight viewer window.  The scale starts at 
10% (most transparent background) and goes up to 100% (completely 
blacked out).  

 

Speed:  Alter the speed with which the spotlight viewer responds to 
cursor movements. 

 

Reset: Moves the spotlight viewer back to the center of the screen. 

 

Exit: Will exit out the spotlight tool.   

 

8.6. The Dynamic Tools Toolbar   
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 Live Video Feed – For use with computers that have a live video feed 

currently running through it (e.g. web cam, document camera).   

 

To use the live video feed ensure that a video capture device is plugged 
into the user’s computer.  Click on the ‘live video feed’ icon.  The user is 
then be prompted to select which input device they wish to capture their 
video on. 

 

A Workbook video frame will now open up with the live feed screening in 
the middle.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Along the bottom of the video frame are five buttons: Webcam settings, 

Webcam settings 

Webcam Resolution    Full Screen Mode           Record Video Feed 

Capture Snapshot 



Page P a g e  | 63 

Web cam resolution, Full screen mode, Record video feed, Capture 
Snapshot.  

 

 Webcam Settings: general options for using the live feed.  When 
clicked you get the choice of three tabs: VideoProcAmp, Camera 
Control, and Capture Source: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VideoProcAmp:  

 

               Brightness: Adjusts the ‘black’ levels 

Contrast: Adjusts the ‘white’ levels  

Hue: Alter the light frequency in the colour 

Saturation: Adjusts the vividness of colour 

Sharpness: Alters the clarity of the image 

Gamma: Makes the image darker or lighter 

White balance: Alters the photo so that objects appear whiter 

Backlight comp: Increase the exposure 

Power line frequency: (Anti Flicker) 

- Select your regionally defined Mains frequency to 
ensure that you eliminate excess flicker on the feed.  

 

If you select the ‘Auto’ box next to an option the camera will automatically 
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adjust to an ‘ideal’ setting.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Camera Control: 

 

               Exposure: Alter the amount of light let into the camera 

Zoom: Zoom the webcam in and out.  

Pan: Pan the camera left or right.  

Tilt:  Tilt the camera up or down  

Flip: 

- Horizontal – Horizontally flips the live feed 

- Vertical – Vertically flips the live feed 

              Roll: Rolls the camera 90 degrees   

              Low Light Compensation: Camera adjusts for low light levels 

              Default: Resets the settings to the default level. 

 

If you select the ‘Auto’ box next to an option the camera will automatically 
adjust to an ‘ideal’ setting.  
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Capture Source: 

 

                Select the device from which you wish to capture the live feed 
from. Use the drop down menu to view and select the source.   

 

 Webcam Resolution:  

 

Users can edit the size of the video they wish to capture.  

 

 

 

 

 

 

 

By changing the resolution size (left hand drop down menu) users can 
determine the  quality of the live feed and any subsequent recording.   

 

 Full Screen Mode 

  

      Turns the live feed into the dominate/only object on the screen.  When 
in full screen mode when you right click on the video you’re given a 
range of options.  
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The menu contains: capture snapshot, web cam settings, webcam 
resolution and a close button.  

 

 Record Live Feed 

 

Once this mode is engaged Workbook begins to record the live feed.  
Once the recording has finished click the ‘export video feed’ (a film icon 
that replaces the ‘record video feed’ icon).  After a loading sequence 
the recording will appear on the Workbook canvas as an “active object” 
within the multimedia window. The recording is also stored in the 
attachments list and can be saved onto your computer from there. 

 

 Capture: Whilst the live feed is engaged use the capture tool to take 
snapshots of the feed.  Once you click the capture button, an image of 
the current feed is placed on the top left hand side of your workbook 
canvas.  You can continue to take as many captures of the feed as you 
wish. 

 

Using Multiple Live Feeds 

 

Workbook provides users with the ability to engage more than one live 
feed on your Workbook canvas (e.g. 2 web cams).  To do so, open up the 
first live feed.  Then open up another live feed (simply click the icon 
again), head to ‘web cam settings’ and select the second live feed device.  

 Rich Text Box - The Rich text box is ideal for text input.  Once clicked, 

the Rich text box appears in front of the Workbook page and provides the 
user with a blank box from which they can input text.   

 

 

 

 

 

 

 

 

 

The Rich Text box provides the user with a range of tools for adjusting the 
text size, style, colour, formation, with the advantage of being able to edit 
parts of the text – rather than the whole lot.  Once the text has been 
inputted and edited click on the red cross (top right-hand corner).  To re-
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edit text, double click (tap) on the text.   

 

Insert Link: Insert a link to a web address.  Highlight a piece of text that 
you wish to attach the link too.  Click on the ‘insert link’ icon.  Enter the 
link into the address.  

 

Edit Source HTML: Users are given the ability to input HTML code into 
the rich text box. By clicking on the ‘edit source html’ icon an HTML 
window opens. The window contains two boxes.  The top box is where the 
HTMl code is inputted.  Then lower box is a preview window for what the 
code will look like.    

 

 

 

 

 

 

 

 

 

View mode: Preview what the text box content will look like.  

 

Rich Text Box Tables - You can also add editable tables to your 
workbook page through the rich text box.  To access the tables feature 
click table box will now appear: 

 

 

 

 

 

 

Choose the amount of rows and columns you would like within the table 
(these are all editable once the table is created) and if you wish to have a 
thick black outline around the boxes.  Once you choose ‘OK’ the editable 
table will now appear in your rich text box. You’re able to input text into 
the table, as well as alter the number of columns and rows.  

 

Add a row (click on any square within the table then click the icon) 
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Add a column (click on any square within the table then click the icon) 

 

Delete a row (click on any square within the table then click the icon) 

  

Delete a column (click on any square within the table then click the icon) 

 

 Character Map –character map is an index window that contains a 

range of subject based character sets that can be used on the Workbook 
canvas. 

 

Once the icon is clicked the index window will appear. Click on the ‘select 
category’ drop down menu. A drop down menu will now appear with the 
range of character sets available.   

 

 

 

 

 

 

 

 

 

 

 

Select the character set you’d like to use.  

 

 

 

 

 

 

 

 

 

 

Preview window 
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As you hover over each individual character within the set that character 
will appear in the preview window in the top left hand side.   To place the 
character onto the canvas click on the character.  The window will now 
close and the character will be placed onto the canvas.  

 

 Web Browser - The Workbook web browser provides the user with a 

fully functioning web browser on their Workbook canvas.  Upon clicking the 
icon a web browser will appear on the user’s current page as an ‘active 
object’.  Users are greeted by a Workbook Web page that provides them 
with a range of search options and specific links. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Go Back – Return to the previously viewed page 

 

Go Forward – Undo ‘go back’ 

 

Refresh – Refresh the web page 

 

Home page – Return to home page 

 

Screen shot – Take a snapshot of the webpage – the will appear on your 
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workbook canvas 

 

New Tab – Creates a new tab within the Web browser 

 

Along the top of the Web browser are two menus: 

 

File Menu: 

 

      Save as: Saves the current webpage as a file on your computer. 

      Print: Prints the current web browser page 

      Exit: Closes the Workbook web browser 

 

Navigation 

 

New Tab: Opens a new tab in the web browser 

 
Reload Tab: Refreshes the front Tab  

 

Close Tab: Closes the front Tab – if only one tab is open then the 
browser will close 

 

The Home page/Xorro portal  

 

When you first open the Workbook browser you’ll be taken to the Xorro 
portal – a specially designed Xorro web page.  There are a number of 
features on this web page: 

 

Google search: type a search topic into the search bar and click ‘Search’.  
The user is then taken to a Google page listing the results of their search. 

 

Wikipedia search: type a search topic into the search bar and click 
‘Search’.  The user is then taken to a Wikipedia page relating to the 
searched topic.  

 

To access a web page, click on the white address bar located along the top 
of the page and type the desired URL address in and click ‘GO’.  To return 
to a previous page click ‘Back’, likewise, to return to a previous page 
visited before ‘Back’ was clicked, click ‘Forward’.  
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To copy text or images from the web browser onto your Workbook canvas, 
drag the image, or select and drag the text, onto an open space of the 
Workbook page.  Note that hyperlinked images (ones that when clicked 
link to a different page) will not drag and drop onto the canvas, instead it 
will display the hyperlink address.  In such a case, right click a hyperlinked 
image and select copy, then paste in onto the canvas.  You may choose to 
use the capture tool to select and capture a section of the browser (for 

capture refer to the ‘Tools’ toolbar section). 

 Activity - provides access to a range of customisable activities that are 

bundled within Workbook.  Once selected a folder will appear containing a 
range of their custom flash activities.  To run any of the files, double click 
on the file.  The flash file appears on the page as an ‘active object’. 

 Format Painter - provides users with the ability to select an object on 

their Workbook canvas, save the stroke colour, fill colour and fill label 
colour from that object and then manipulate the colour of other objects on 
the page to match the initially selected object.  

 

To use format painter the user creates an object (initial object) on their 
Workbook page (pen, line, shape etc..) with a colour/properties scheme 
that they wish to replicate on other objects.   

 

 

 

 

 

 

 

 

 

 

 

The user selects the object (with the properties that wish to replicate) 
using the select tool (refer to the ‘Mode select’ toolbar) and then clicks on the 
format painter tool icon.   

 

 

When the cursor is dragged across another object on the canvas it will 
change into the paint brush icon.   
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The user can now click on the object and its colour scheme will change to 
that of the initial object.  

 

 

 

 

 

 

 

Note: If you double click on the ‘format painter icon’ the colour scheme can 
be used on multiple objects. If the user only clicks once on the icon, then 
the colour settings will only last for one object.  

 
Cropping tool. 

 

The Workbook cropping tool provides users with the ability to take an 
image on the Workbook canvas, select a rectangular area within that 
image and delete the unselected area.   

 

To use the cropping tool click on the ‘cropping tool’ icon, located in the 
‘dynamic tools’ toolbar.  Once the icon is clicked the workbook canvas will 
then become partly blacked out.  Along the left hand side of the canvas 
(over the blacked out area) a list of the images currently on the Workbook 
page will appear.   

Select the image you wish to crop.  It will now appear in the middle of the 
screen.  
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To crop the image, click and drag across the main image, creating a square 
area that you wish to keep.  Once you’ve selected the ‘keep area’ release 
from the drag motion.   

 

 

 

 

 

 

 

 

 

 

 

 

A ‘crop’ button will appear in the right hand corner.  Once you click this 
button the ‘keep area’ of the image will remain whilst the unselected areas 
will be cut from the image. The image in the centre of the screen will now 
show the cropped image.  

 

Once you’re done cropping images on the canvas click the cross in the top 
right hand corner.  Workbook will now exit out of ‘crop mode’ and return 
you back to the workbook canvas, where the cropped image(s) will be.    

 

Crop button 

Exit 

Canvas images 

Selected image 
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Transparency Tool -  

 

Workbook’s Transparency Tool provides a way of easily and quickly 
eliminating colour or boundary effects from inserted images.   

 

Often, inserting an image into Workbook brings 
with it unwanted elements such as a border, or 
a background.  As a result, the imported item 
does not integrate well with other items on the 
canvas.  The simple example shown at right is 
that of a clock face inserted in this case onto a 
canvas with a coloured background.   

 

The result would be improved if the white square background of the clock 
face image, could be removed to yield either : 

 

A. all white of the clock face so that the numbers and clock hands 
and outline appear directly on the coloured canvas, or 

B. the clock face retains its white background but the white 
background of the square image is removed so that the round 
clock appears to float directly on the canvas 

 

 

 

 

 

 

 

 

Upon pressing Workbook’s Transparency Tool icon, a dialog window opens 

 

 

 

 

 

 

 

B A 
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momentarily to permit the user to adjust the sensitivity of the tool, and to 
choose whether a “Global” or a “Local” application of the transparency is 
wanted. 

 

Applying transparency to an image using “Local” means that colours 
adjacent or connected to the colour at the position selected, will be made 
transparent.   

 

Applying transparency to an image using “Global” means that the colour at 
the selected location will be made transparent, anywhere in the image (ie 
not necessarily adjacent to or connected to the selection location). 

 

The Tolerance scrollbar permits the user to determine how sensitive the 
transparency application should be.  At the extreme left end of the 
scrollbar, only colours very close to that at the selection point, will be made 
transparent.  As the scrollbar is moved to the right, a wider tolerance of 
colours may be made transparent. 

On moving the mouse away, the cursor will now change to a wand 
with a red cross on it while hovering over an area (eg the canvas) to which 
no transparency can be applied.   

Once the cursor hovers over an area to which transparencies might be 
applied, the cursor changes to an “active” wand (no cross).   

 

By clicking (or touching) the item (eg image), the colour at the touch point 
will be made transparent, as well as either adjacent and connected colours 
(in the case of “local” applications), or all other locations using that colour 
on the image (in the case of “global” application of transparency). 

 

Examples: 

The diagram below left is acquired from a web site and pasted onto the 
canvas.  The user wants to eliminate the white background in the diagram.  
To this, user presses the Transparency Tool; selects “local”, moves the 
cursor over the white area on the diagram, and clicks (or touches).  The 
result is that the white background is eliminated (right).   

 

Notice that the white areas on the buttons of the cellphone, or the rim of 
the wi-fi phone, have not been made transparent.  This would have 
happened had the user selected “global” instead of “local”, as all cases of 
white on the image would have been made transparent, and not just white 
areas connected to the touched location. 
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Hints for use:   

Experiment with the Tolerance scale for best results.  Too low a tolerance 
and it will take a long time to achieve the desired result; too high and you 
will degrade parts of the image you want to preserve. 

You may need to undo the Transparency effect (ctrl-z to undo) , and 
re-apply it with a changed Tolerance, or switching from Local to Global or 
vice versa, depending on the desired effect. 

 

For best results, choose images with high contrast, and with clearly defined 
boundaries for the elements you want to preserve.  When images involve 
many graduations of similar colours, it will be difficult to get good results 
from the Transparency tool.  For example, consider the choice of the 
following two images of Stalin, the Russian dictator: 

 

The image on the left features a range of similar tones which will prove 
more difficult to segregate than is the case with the stylised image on the 
right.  In the case of the latter, simply clicking on the blue area with a 
moderate to high level of tolerance creates a very versatile end result.  The 
orange frame around the perimeter may similarly be eliminated, to end 
with the image at right (rotated for emphasis) which is suitable to “float” 
over the canvas or to be incorporated with other images into a collage. 
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 Insert Media 

 

Opens a window for users to search their computer and input media onto 
their Workbook canvas.  

Users select the file they wish to insert and click ‘open’.  

 

 

 
Resource finder 

 

Provides the user with the ability to search for images, video, and textual 
definitions on specific subjects from web databases.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

search subject 

media type 

results window 

download location 

previous/next page 

 

download button 
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Once clicked the resource finder search window appears.  

 

Along the left hand side are three ‘media type’ search tabs: Text, Videos, 
and Images. 

 

Images: Searches a range of web based image sites for filtered 
images relating to the search topic.  

 

Videos: Searches a range of web based video sites for filtered                   
videos relating to the search topic.  

 

Text: Searches an online dictionary for direct meanings of the 
subject.  

 

Along the top of the search window is the title bar. Once the type of 
multimedia has been selected, users input their search subject into the 
search bar along the top of the screen. Users can then click ‘select’ and 
initiate the search.  

 

A range of search results will then appear in the search space.  For image 
and video files a thumbnail will appear, along with a title, and a box to the 
left of the title.  To insert a piece of media onto your canvas, click and drag 
either the thumbnail (for image and video) or the piece of text (for text) 
onto your canvas. 

 

To view another page of results click on the arrow icon on the bottom right 
hand side of the search box.  To go back to the previous page of results 
click on the arrow icon on the bottom left hand side of the search box.  
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Downloading media: Workbook search provides users with the ability to 
download and save files into folders on their computer (rather than straight 
onto t heir workbook canvas).  Users can choose which folder they wish to 
download the file into by clicking on the ‘dotted’ icon at the bottom of the 
search window (next to the download location bar).  Users then select a 
destination folder from the display window.   

 

Users then select the image(s) or video(s) they wish to download by ticking 
the boxes next to the images and clicking on the download button at the 
bottom of the screen. The selected media is then saved in the folder 
displayed in the ‘download location’ bar.  

 

To exit out of the search window click the red cross on the top right hand  

side of the search window. 

 Xorro Q Responder – For further information on Xorro Q responder link 

refer to the Xorro Q section. 

8.7. The Geometry Toolbar   

 

 

 

 

 

 

 

Opens Workbook ruler.  

 

 

 

 

 

 

 

 

 

 

 

The Workbook ruler will sit on top of your workbook canvas and the 
various object on it.  The ruler can be moved around the canvas by 
clicking and dragging it. Use the select tool (refer to the ‘Mode select’ toolbar 

section) to access the various options. 

Line Draw tool 

Rotate 
Options 

Resize 
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Resize: Drag the pink circle to increase or decrease the size of the                               
ruler 

 

      Rotate:  Rotate the ruler around its axis 

 

      Options:  

- Clone: Places a clone of the ruler onto the workbook 
canvas 

- Unit: Select the unit of measurement for the ruler; 
either pixels or centimeters. If cm is selected it will 
ask you to input the current length of the ruler in 
cm. 

- Order: Select where the ruler will sit on the page 
relative to other objects and the background.  

- Delete: Delete the ruler 

 

      Line Draw Tool : By selecting the ‘line draw’ icon on the ruler you 
can now draw a line that follows along the top of the ruler.  Once you 
close the ruler the line will remain on the page.   

 

Making the ruler transparent: 

 

The Workbook ruler can be made transparent by selecting the ruler once 
it’s on your canvas and using the opacity tool (refer to the ‘property select’ toolbar 

section). 

 

  

 Draw perfect circles with Workbook compass.  

 

 By clicking on the compass you’ll open up the Workbook compass 
menu (displayed on the right).  The options in this will alter the way 
you use the compass tool. 

 

 Show Info - Displays the size of the radius and the angle 

of the drawing point from the start point within the circle 

when you’re creating it.  Tick the box to show the 

information.  

 Clockwise – Denotes the direction you draw your circle.  

Tick to create the circle clockwise, un-tick it to create it 
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anticlockwise.  

 Copies – Dictates the amount fo copies of the circle 

created.  If you select ‘3’ then 3 copies of the circle will be 

placed on top of each other.  

 

 Once the icon is clicked your cursor is dragged over the camps it will 
change to display a compass, you’re now in compass mode; all 
other workbook modes are disabled until you exit compass mode.   

 To begin, choose a center point for your circle and click on it.  A 
circle will appear.  

 Then, click on where you want the perimeter of the circle to be and 
drag around the center point in a circular fashion – a blue line will 
appear showing you the arc of your circle. As you draw the circle 
the menu reports the radius (in pixels).  

 Once the arc is complete stop clicking.  

 The circle will now appear and have the properties of a  

 To exit out of compass mode select the cursor tool or any other 
workbook tool.  

9. Customisable Personal Toolbar   

 

 

 

The customizable personal toolbar provides users with the ability to create a 
Workbook toolbar with annotation tools, links  

Using the Personal Toolbar, users can customise their preferred tools to include their 
favourite pens, lines, shapes, links and shortcuts.  This is a tremendous time-saver, 
providing you with instant access to exactly the tools you prefer to use.  You will find 
that spending ten minutes to set up your Personal Toolbar will pay dividends in your 
future use of your Workbook. 

There is no limit to how many personal tools you can add to this toolbar.  Remember 
also, that these tools will be available outside of the Workbook as well. 

The initial Customisable Toolbar will contain 5 icons: 

 

 Customisable personal toolbar icon provides users with the ability to 
add, remove or edit tools within the toolbar.  

 Select tool (refer to the ‘mode select’ toolbar section) 

 Eraser tool (refer to the ‘mode select’ toolbar section)  
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9.1. Adding to the personal toolbar 

 

 

 

 

To add a personalized tool, click the ‘customisable personal toolbar’ icon to expose 
the list of currently installed tools.  

 

 

 

 

 

 

 

 

Select the “Add” button to add a new tool using the Personal Tool button utility. 
Once the “Add” button is clicked the custom figure window appears.  

 

 

 

 

 

 

 

 

 

By using the tool type drop down menu, users can select the type of tool they wish 
to add.  

You can choose between four types of tool: 

Custom Figure: Choose from a range of Mode select tools that includes pens, 
shapes, custom polygons, lines, connectors and text. 

current tools 

add a new tool 

edit a tool 

delete a tool 

move a tool up  

the order 

move a tool down  

the order 

tool type 

tool name 
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To create a custom figure, select the type of tool you wish to create.  Next, select 
the properties for that tool from the properties menu. 

Once a tool and its properties have been chosen the user decides if they want to give 
the tool a name.  If so, the name is typed into the box next to ‘label’ and ‘show label’ 
is ticked.  The user then clicks ‘OK’. 

Start Program: this allows the user to create a button which “runs” an external 
utility, for example an on-screen keyboard (run C:\WINDOWS\system32\osk.exe), a 
magnifier, a screen recording utility, or a specialised drawing tool. 

 

Once the utility has been browsed for, users can add a name to the utility and then 
click ‘OK’. 

Open Folder: this allows you to create easy links to preferred folders or libraries. 

 

To add a folder, click “Browse”. A search window will appear.  Users can then search 
their computer for folders that they wish to add to their customisable toolbar.  Once 
a folder is selected users can decide to give it a name. If so, the name is typed into 
the box next to ‘label’ and ‘show label’ is ticked.  The user then clicks ‘OK’ 

Web Link: Users can create links to web addresses. 
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Users type the URL address for the webpage into the white box next to “Link”.  Once 
a URL is typed in users can decide to give it a name. If so, the name is typed into 
the box next to ‘label’ and ‘show label’ is ticked.  The user then clicks “OK” 

Once users click ‘OK’ (for any tool type) the tool is added to the customisable toolbar 
and the user is taken back to the list of installed tools.  The user then clicks ‘OK’. 

Mode Select: 

Users can choose from a range of basic Workbook functions to add to their 
customizable toolbar.  

 

Cursor: Add a cursor to the toolbar.  The cursor provides users with the ability to 
control objects on the canvas.  

Eraser: Users can create a customized sized eraser for their toolbar. Users select the 
button next to the eraser icon and then use the slider to determine the size of the 
eraser. 

Internal tools 

Select from a range of Workbook tools to be added to your toolbar.  Select the icon 
of the tool that you would like added, select ‘show label’ if you want a label and click 
‘Ok’.  

Editing or Deleting a customizable toolbar tool: To edit or delete a tool off 
your bar, click on the “customizable toolbar icon”, select the tool within the toolbar 
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list and then click “delete” or “edit”.  Likewise, to move objects right or left along the 
toolbar, select the item in the list and then click either move up or move down. 

9.2. Creating Multiple Customisable Toolbars  

Workbook provides users with the ability to create multiple custom toolbars (you will 
always begin with just one customisable toolbar).  To create additional customisable 
toolbars access ‘customise toolbars’ under the ‘Tools’ menu. 

 

Workbook will then provide the user with a ‘customize toolbars’ menu.  

 

 

 

 

 

 

 

 

 

 

On the left hand side of the menu is an empty window that will display the various 
customizable toolbars that users create. 

 

9.2.1 Creating a new toolbar 

 Click ‘Add Toolbar’ 

 A new window will now appear 

Toolbar list 
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 Enter in the name of your new toolbar 

 Click ok 

 The ‘customisable personal toolbar’ menu will appear and provide users with the 
ability to add to your toolbar. 

 Click ok 

 Exit out of the customizable toolbar screen by clicking ‘Close’ 

 Your new toolbar will now appear with the other toolbars above your Workbook 
canvas. 

 

9.2.2 Turning a customisable toolbar off – without deleting it 

Once you’ve created a customizable toolbar you can stop it from appearing with the 
other toolbars above your canvas (without deleting it) by: 

 Open up the ‘View’ menu.   

 Head down to ‘Toolbars’ 

 You’ll now see your custom toolbar listed at the bottom of the menu 

 Click on the toolbar (unticking it) 

 

 

9.2.3 Turning a customisable toolbar back on 

 Open up the ‘View’ menu.   

 Head down to ‘Toolbars’ 

 You’ll now see your custom toolbar listed at the bottom of the menu 

 Click on the toolbar (ticking it)  
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9.2.4 Deleting a customizable toolbar 

To delete a customizable toolbar (excludes the original toolbar) enter the 
‘customisable toolbars’ menu (refer to the ‘tools toolbar’ section) and highlight the toolbar you 
wish to delete (within the window on the left hand side) and select ‘remove’ on the 
left hand side. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Toolbar list 

remove 

Export toolbar 

Import toolbar 
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9.2.5 Exporting and importing toolbars 

Workbook provides users with the ability to import and export customizable toolbars. 
Users can export toolbars they’ve created, or import toolbars that other users have 
exported. 

To export a toolbar select it in the ‘customizable toolbar list’ and click ‘Export 
Toolbars’.  Users will then be prompted to select a location to save the toolbar 
through a search window. Once the user selects the location and clicks ‘save’ a 
version of the toolbar will be saved for others to import.  Note that exporting a 
toolbar will not delete it from your current workbook file, it will simply create a copy 
of it.  

To import a customizable toolbar open the customizable toolbar list’ and click ‘Import 
Toolbars’. Users will now be able to search their computer/network through a search 
window for a workbook toolbar.  Once the toolbar is found and selected click ‘Open’.  
The toolbar will now be added to your workbook toolbars.   
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10. Xorro Q Participation  

Within Workbook there is a link to the Xorro Q response solution.  At the end of the 
dynamic tools toolbar you’ll find the Xorro Q icon. Xorro Q is a subscription based 
response system and requires a code acquired by purchase or 30-day trial.  

 

  Xorro Q: 

 

By clicking on the Xorro Q icon you are presented with a range of options 
for answering questions via the Xorro Q responder. This works in 
connection with the Xorro Q web facilitator. 

 

 

 

 

 

 

 

 

 

Once you’ve selected an option (option review below) you’ll be asked to login.  

 

 

 

 

 

 

 

 

 

 

 

 

Enter in your email and Xorro Q password (acquired through purchase or 
trial) and click ‘submit’. Once you’ve logged in the Xorro Q session will 
begin.  If you tick the box next to ‘save credentials’ it will save your login 
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and password for the next time you login. 

 

The next screen that appears will detail the participant options. 

 

 

 

 

 

 

 

 

 

 

The first drop down menu is ‘Group’: 

 

 

 

 

 

 

 

Group refers to the group of participants you wish to include for the quiz.  
Groups  are pre-created using the web facilitator if you have a pre-created 
a group you can select it from the drop down list.  If you don’t wish to use 
a pre-created group then select ‘None’.  

 

The second drop down menu is ‘Access’: 
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Access provides users with a drop down menu listing the individual 
identification display style of the participants.  

 

If ID is selected 

 

 ID:  As participants login they enter in a pre-created ID name that 

has been setup by the session leader using the web facilitator’s 

participant record  

 Alias: The participant can enter their own name when logging into 

the system.  

 ID + Alias:  The participant can login using either their pre-

created ID or a preferred Alias.  

 Selected Group: Only works when a previously created group (refer 

to web facilitator) is selected under the ‘group’ drop down menu.  By 

selecting ‘Selected Group’ only participants from the group can 

login.  They login by entering their ID name.  

 

Once you’ve selected both a ‘Group’ and ‘Access’ type logged into a session 
the Xorro Q floating toolbar will appear.  

 

 

 

The toolbar provides the user with a range of options for question type, 
access to web facilitator and exit from Xorro Q.  
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Multi-Choice: Initiate a multi-choice question n (refer to below) 

Text Question: Initiate a text question  

Web facility: Opens the user’s web facilitator (refer to web facilitator) 

Exit: Closes Xorro Q 

Collapse: The collapse button will collapse the floating toolbar down to 
the Xorro icon (see below).  To reopen the toolbar, double click on the 
icon.  

 

 

 

 

 

 

 

Multi-choice: 

 

Initiate a 2, 3, 4 or 5 choice multi-choice question.  

 

Before initiating any of these options you’ll need to pre-create the question 
and a range of multi-choice answers on your Workbook canvas (eg. Below) 

 

 

 

Multi-choice 

Text Question 

 

Web facility 

Exit 

Collapse 
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Once you’ve created your question click on the Xorro Q icon and selected 
the option that resembles the number of answers you have. 

 

Initiates a 2 answer quiz. 

 

Initiates a 3 answer quiz 

 

Initiates a 4 answer quiz 

 

Initiates a 5 answer quiz 

 

Once you’ve selected the quiz option and logged in your Xorro Q 
respondent screen will appear. The respondent screen encompasses the 
login details for the respondents as well as response results. The 
respondent screen will remain on top of all applications. 
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Login details: QR code and Url for respondents to login in with.  

Results Graph: Instantly updated graph showing response votes for each 
multi-choice option 

 

 



Page P a g e  | 95 

Answers Received: Number of respondents that have answered   

Unanswered Respondents: Number of respondents that haven’t 
answered 

 Hide/Show QR code: Close or re-open the QR code display 

Hide/Show results: Hide or re-open the results graph. 

Show/Hide Legend: Displays the answer options in a small window 

 

 

Next to the QR code are 4 buttons: 

 

 

 

 

 

 

 

 

 

 

Copy Code: Takes a copy of the code, which the user can then paste. 

Save Code: Saves a png copy of the QR code 

Print Code: Prints a copy of the QR code 

Enlarge Code: Enlarges the QR code to full screen 

 

 

 

 

 

 

 

 

 

 

 

 

Exit Full Screen 

Copy Code 

Save Code 

Print Code 

Enlarge Code 
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 Full text response 

 

Full text response provides users with the ability to gather full text answers 
from their audience.  

 

Before initiating any the text option you’ll need to pre-create the open-
ended question you would like responded to on your Workbook canvas.  

                        

Once you’ve inputted your question onto the page click on the Xorro Q 
icon, selected the ‘text response’ icon and logged in your Xorro Q 
respondent screen will appear. The respondent screen encompasses the 
login details for the respondents as well as response results. The 
respondent screen will remain on top of all applications.  
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Results list:  Lists all text based responses 

Show/Hide Names: Hides the names of respondents 

 

Within the results list you’ll receive the responses from the audience.  You 
can drag individually drag these results onto your workbook canvas. 

 

 

 

 

  

Pre-create a quiz  

 

You can pre-create questions and then initiate them later using the pre-
create function. 

 

Select the ‘create’ button from the Xorro Q drop down menu.  The pre-
create question icon will now appear on your workbook canvas.  

 

Select the ‘pre-create question icon’ by clicking on it. 

 

 

 

 

 

 

 

 

 

 

Rotate: Rotate the question box by clicking and dragging left or right.  

 

Edit Question:  Edit the question you would like answered. 

Reveal/Hide question 

Options 

Edit Question 

Rotate 



Page P a g e  | 98 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Select Question Type: Select if you want to create a multi/choice or 
full text question type.  

 

 Question Text: Insert the Question 

 

 Question Options (only for multi-choice): Insert the various mutli-
choice questions. 

 

 

After the question is created the Edit icon will change to a green play 
button. 

 

 

 

 

 

 

The green button will initiate the question  

 

Options: Click to reveal a range of options for the pre-create question icon. 

 

Insert answer options 

Insert Question text 

Select Question type 
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 Clone: Create a copy of the question.  Copy will appear directly 
above original on the canvas. 

 

 Edit: Opens up the ‘edit question menu’ 

 

 Order:  Select the depth-position of the question on the page 
relative to other questions. 

 

 Delete: Deletes the question.  

 

Reveal/Hide question: Click this icon to reveal or hide the question you’ve 
created. 

 

Initiating the question 

 

Once you’ve created the question you can initiate the question by clicking 
on the green play button.  

 

 

 

 

 

 

 

 

 

The Xorro Q respondent window will now appear (refer to the Xorro Q section). 

 

 Respondents login 

 

Once you’ve initiated your Xorro Q quiz your respondents will be required 
to login.  To answer the questions you’ve posed respondents need to 
access a specific web page that contains your question and an answer 
section. 

 

Respondents can access this web page in two ways: via the QR code or the 
URL displayed on the respondent screen.  

Initiate question 
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QR Code: A QR code is a barcode that links the user to a distinct web 
page (the same as the URL).  You’ll require a QR barcode reader on your 
smart mobile device to be able to read it.  If you don’t have one then 
simply use the URL provided. 

 

URL: Respondents simply enter the URL into the web browser of their 
device (any web enabled device will work) as an alternative to the QR 
code. 

 

Once the Xorro Q page has been accessed the respondent will be 
prompted to enter in either their name, or ID.  

 

 

 

 

 

 

 

 

 

 

 

 

 

QR Code 

URL 
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Respondents enter their name and click ‘Go’. 

The quiz will now appear on the user’s web browser.  

 

If you’ve selected a standard quiz (not pre-pared) the respondent will get a 
list of A, B, C etc.. that reflects your question.  

 

They select the answer and click ‘Submit’ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you’ve chosen to run a Text answer question (not prepared) then they 
will get a screen displaying a ‘You say’ box.  Respondents then type their 
answers into the ‘You say’ box and click ‘Submit’. 
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A list of their submitted answers will appear along the bottom of the 
screen.  

 

Using a prepared quiz 

 

If you’re using a prepared quiz then the questions and answers (for multi-
choice) will appear on the users screen.  

 

 

  



Page P a g e  | 103 

 

10.1. Xorro Q Web facilitator  

 

 

 

  Xorro Q Web facilitator: 

 

 

The Xorro Q web facilitator is a web site designed specifically for 
Facilitators and Presenters. It provides the users with an easy to use online 
application that allows them to create groups of questions, setup class 
groups and respondent records, track results, and even launch activities of 
different sorts.  

 

Accessing the web facility: 

 

Users can access the Web Facilitator in two ways: via a url or from 
the Xorro Q Launcher toolbar.  

The “QF” button on the Xorro-Q Launcher toolbar links directly to the 
Web Facilitator, placing the user directly into the currently running 
activity. 

 

 

 

Web facility 
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Please note that in this case the landing page is not the facilitator’s 
home page on the site, but rather is the results display for the 
currently running activity.  

To access the web facilitator via a web browser browse to  

http://qf.xorro.com/ 
You will be required to log in to the page if you have not already 
done so from the Xorro-Q login process on the desktop. 

Once logged in, you will be directed to your Facilitator home page. 

 

 

http://qf.xorro.com/
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Home Page: 

 

The Xorro Q home page displays recently created activities and results.  

 

 

 

 

 

Recently Prepared Activities: Contains a list of recently created Xorro 
quizzes/activities.  You can run any selected quiz/activity by clicking on 
‘RUN’.  This is helpful if you are wanting to launch an activity while in class 
and are not using the Xorro-Q Desktop Launcher. 

Logged in user  
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Recent Results: List of results from recently run Xorro quizzes/activities.  
Selecting one of these is a quick link to the results for that activity. 

 

  

 

Logout: To logout from the web facilitator move mouse over User Name 
on the top right of the page. Click on the grey ‘Logout’ button.  

 

 

 

 

 

Activity Page: 

 

Xorro-Q Web Facilitator’s ‘Activities Page’ provides users with the ability to 
create, run and review the results from Activity sessions.  

 Accessing the Activities page:  

A version of the activities page is presented when accessing the Xorro-Q 
Web Facilitator from Xorro-Q’s Launcher toolbar (in which case the 
currently running activity is selected).   

The general version of the Activities page is accessed by clicking on the 
‘Activities’ tab at top right. 

 

 

 

 

Pressing the Activities tab presents the ‘Activities index page’.  

 User Name  

  Logout Button 
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Activities Menu 

Lists/filters created activities and their results 

 

 

 

 

 

Running activities: Presents a list of currently running activities. 

Once clicked the screen will now show a list of currently running 

activities.  

 

 

 

 

 

 

 

Activity 

Menu  

Filter Menu  

Group  

Menu  

Create Activity 
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You can access the results page for an individual activity by clicking on the 
title of the activity. Only finished activities display results.  

You can stop any activity from running by clicking on ‘Finish’  

 

Order by: Change the order of the activities by selecting the drop down 
menu next to ‘order by’.  You can order by date created (newest first) or 
alphabetically.  

Items: You can select how many activities you want displayed on the 
page at once by using the drop down menu.  

Delete:  You can delete an activity by using the cross next to the run 
button of an activity, or by selecting the activity (click on the box next to 
the activity) and clicking on the ‘Delete’ button.  

Run: You can engage an activity by clicking on the ‘Run’ button next to the 
activities details. Once clicked the facilitator will display a ‘launch window’. 

 

 Results: Provides a list of sessions run using the various activities. 

Users can access the results of each session through the ‘results’ 

page.  
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Order by: Change the order of the sessions by selecting the drop down 
menu next to ‘order by’.  You can order by date the session was delivered 
(newest first) or alphabetically.  

Items: You can select results of how many sessions you want to be 
displayed on the page at once by using the drop down menu.  

Delete:  You can delete a session’s record by using the cross located on the 
extreme right side of each result.  

Accessing Results: By clicking on the name of the session users can 
access the results from the session  

Filter Menu: Filter the results by session type 

 

 

 

 

 

 

 Real-Time: Only include real-time activities 

 Self-Paced: Only include self-paced activities 

 

Filter by Group: Lists all of the created groups and allows the user to 
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filter by just a selected group or all participants. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create an Activity 

To pre-create an activity using the web facilitator use the ‘create activity 
button within the ‘activities page’. 

Once clicked you get the ‘New Activity’ screen.  
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 Activity Title : Enter in the title/ name of your activity 

 Activity type: Use the drop down menu to select the type of 

question delivery method. (Self-Paced or Real Time) 

 Self-Paced: Respondents move onto each question in their own 

time 

 Real-Time: Respondents answer each question as a group.  

 Login Type: Determine the way each individual user is identified. 

 

 ID:  As participants login they enter in a pre-created ID 

name that has been setup by the session leader using the 

web facilitator’s class record  

 Alias: The participant can enter their own name when 

logging into the system.  

 ID + Alias:  The participant can login using either their pre-

created ID or a preferred Alias.  

 Selected Group: Only works when a previously created 

group is selected under the ‘group’ drop down menu.  By 

selecting ‘Selected Group’ only participants from the group 

can login.  They login by entering their ID name.  

 Group: If ‘selected group’ is chosen for the login type then this 

drop down menu allows the user to select which group they want to 

run the session with.  

Once you’re ready to run the session click ‘Create Activity’. You’re then 
taken to the ‘Activity information’ screen.  

 

 Activity information along the left hand side details the 

information placed in via the ‘New Activity’ screen. You can edit this 

information by clicking ‘Edit’.  

 

 



Page P a g e  | 112 

 

 

 

 Create Question: Provides users with the ability to create 

questions for their session.  Once “Create Question” button is 

clicked, the ‘New Question’ screen is opened. Questions also can be 

imported from QBank using the “Import Questions” option. 
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 New Question: Enter the question into the text space provided.  

 Question Type: Select from the drop down menu the question 

type you would like to create. Multi-choice (select one): Create 

a multi-choice question that allows only one answer selection.  

 Hotspot (select one): 

 Hotspot (select multiple): 

 Text: Users respond to your question with full text answers  

 Numeric: Users respond to your question with numbers 

 Multi-choice (select multiple): More than one answer can 

be correct  

 Multi-choice (select multiple): More than one answer can 

be correct. 

 Likert scale: Select a specific section or sections of the 

picture/ artwork  

 Information: User gets information  

To create a Multi-Choice Question, User types in the question on the Text 
area. 

Users can enter in different selection options on each line.  The correct 

answer can have a ticked placed next to it by clicking on the individual 

square next to the answer.  

 

 Allow multiple submissions: The user can dictate how many 

answers a repsondent can submit.( In case of Real time 

Questioning). 

 

 

 

 

 Answers can only be submitted once: One answer per 

respodent 

 Answer can be submitted multiple times: More than one 

answer per user 

 Replace previous answer: User can send in a new answer 

but it replace their previosuly submitted answer for that 

question.  

 

 Create Question: Creates the question and places it onto the 
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‘activity information’ screen.  

 

 

 

 

The newly added question will have its section detailing its name and 
question type, along with any other questions added.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Move 
Clone 

Edit Question 
Delete Question 

Move Down 

Join 
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 Edit Question: Users can edit the individual question. Once clicked 

the original question creator screen appears and the users can edit 

any of the aspects of the question. 

 Delete: Delete the individual question 

 Clone: Creates copy of the question and joins it with the original 

one 

 Move Down:  Move the question down the order 

 Move Up: Move the question up the order 

 Join (Only appears in Real-Time activities):  Using the “Join” 

command, you can join questions together into a question batch. 

These batches are then delivered together to the respondents, and 

they can answer each of the questions in the batch at their own 

pace.  Once a batch is completed the facilitator can launch the next 

question (or question batch).  

Once questions are joined they appear connected.  

 

 

 

 

 

 Unjoin: Breaks the questions apart 

 Move Up: Move a question up within the joined batch 

 Move Down: Move a question down within the joined batch. 

 

Run the Activity: Once the user has added all the questions they want 
they can run the session by clicking on the ‘Run’ button.  Users are then 
presented with the launch screen.   

The launch screen will differ between ‘Real-Time’ and ‘Self-Paced’ activity 
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sessions 

 

Running an Activity: Once the user has selected to run an activity 
they’re presented with a ’launch screen’.  The information shown on the 
launch screen was created by the user when setting up the activity. Users 
can edit the details.  

 

 

 

 Launch: Once the user is ready to launch the session they simply 

click ‘Launch’. Users will then be presented with the ‘Activity Run 

screen’.  

 

 

 

 

 

 

Activity Run Screen:  Once a session is launched the users can view the 
progress via the ‘activity run screen’ which appears.  
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Please Note:  The run screen will differ slightly between a Self-Paced test 
and a Real Time.  A Real Time test requires the Session leader to initiate 
each question by clicking ‘Ask this question’, whereas Self-Pace provides 
the respondents with the ability to move through the questions by 
themselves – rather than with the group.  

 

 

 

 Participant/ Respondents List: List of respondents engaged 

with the session 

 

 

 Ask Instant: Just as in Xorro-Q’s desktop client, a facilitator can 

instantly ask the audience a question “on the fly”. This is called an 

“Instant Question”.  Users can select an option from the drop down 

menu: 

  Text: Create a text response question 

 True/False: Create true/false question 

 Yes/No: Participants responses yes/no 

 AB: 2 answer multi-choice 

 ABC: 3 answer multi-choice 

 ABCD: 4 answer multi-choice 

 ABCDE: 5  answer multi-choice  

Once the option is selected the question will become live straight 

away.  Results from instant questions are recorded, and may be 



Page P a g e  | 118 

reviewed by selecting the instant question from the question set. 

 QR Code: Shows/Hides the QR code for logging in.   

 

 

 

 

 

 

 

 

 Question Set: Visual list of the questions contained within the 

session. Users can select a question by clicking on it.  

 Finish: Close the session.  

 On the upper right topmost position of the screen, “Results/ 

Progress Bar AND QR Code” options remain. 

 

 

 

 

 

 

Show/ Hide QR Code 
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Progress Bar: Percentage of each answers towards each question 

 

 

 

 

 

Results: Show/Hide live results for the current question. 

Name of the participants can be hidden using the “Hide Name” button. 

Reviewing the results 

A facilitator can choose to review the results from any activity which has 
been run.  Activities are listed with date on which they have been run, 
number of questions answered, number of participants etc.  The results are 
accessed by clicking on the activity name. 

 

 

 

Once the user has selected an activity the results page will appear.  This 
form provides a raw view of all responses to each question.   
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 Export: Users can export the results into a spread sheet by clicking 

on the ‘Export’ button.  

 Summary: Lists the questions individually 

 Raw: Lists the questions in a horizontal list with the results below. 

 Text Responses (Under summary): Text responses appear with 

a list of responses and the participant’s name. 

 

 

 

 

 Multi-choice questions (Under summary): Lists the options 

and the number of votes for that option. 
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Participants 

 

 

 

 

The participants screen provides users with the ability to create individual 
respondent profiles that can be accessed by the respondents when they 
login to a session. Users can also create specific groups of participants.  

To access the participants screen click on the ‘participants’ logo in the top 
right of the screen.  

 

 

 

 

 

 

 

 Viewing a participant 
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Previously created participants are listed in the centre of the screen.  This 
list will vary between selected groups but the group ‘All participants’ will list 
every participant created. 

 

 

 Creating a participant 

To create a participant, User clicks on ‘Create Participant’.  The create 
participant screen appears and users can now input data about the 
participant.  

 

 

 

 

 

 

 

Identification (login ID): The login name that participants can 
use when accessing Xorro sessions 

 

Groups: Instantly place the user into a selected group of users. 
The user will also appear under ‘all participants’.  

Once the information is inputted select ‘create participant’.  The 
participant will now appear in the ‘All participants’ group.   

 

 Groups 

On the left hand side of the screen it details the currently created 
groups.  When you first login into participants you’ll find only 1 
group entitled ‘All participants’.  The ‘all participants’ group is 
where every created participant is stored.  
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 Creating a group: To create a new group select ‘New’ from the 

‘Groups’ menu. The ‘create a group’ screen will now appear.  Enter 

in the group’s name and click ‘Create group’.  

 

 

 

 

The group will now appear in the list of groups. 
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 Adding participants to a group: To add a participant to a 

selected group select the participant in the list by ticking the box 

next to the name and clicking on ‘Add to group’. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The ‘add to group’ menu will then appear.  The menu will list all of the 
user’s created groups. Select the group you want to add the participant(s) 
to by selecting the circle next to the group’s name and then clicking ‘Add’ 

 

 

 

Importing Participants: Users can import an external list of participants 
(csv file) by using the Import participants function.  By clicking on the 
‘Import participants’ button the users can access the ‘Import Participants’ 
screen.   
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Users then select the group they wish to import into via the Group drop 
down menu. They then select the list they wish to import by clicking on 
‘browse to file’.  This will open up a search window where users can search 
their computer for a csv file.  Once the file is found the user selects the file 
and clicks ‘Open’.  The ‘Import participants’ menu will then reappear with a 
list of participants and the group they’re going into.   
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Users then select “Import’ and the Participants are imported.  

Creating an Import CSV file: Most csv files are made using excel spead 
sheet.  You must create three different columns.  In row 1 of column A put 
in the title First, in row1 of column b put in the title Last and in row 1 of 
column C put in the title ID.   Then list the participants below these titles 
(using a row for each participant).  

 

 

 

 

 

 

 

 

 

 

 

 

  

QBank  

 

QBank is the fourth Tab of Xorro Q. QBank helps to store and retrieve 
questions. While creating an Activity it is possible to import a Question or a 
set of Questions from QBank. This section helps Facilitator to select a 
question with the help of Filtering options. 
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Edit Questions: Users can edit an existing Question by selecting the 
Question and then by clicking the “Edit” button.  

 

 

 

 

 

 

 

User can edit a Question and then by clicking the “Edit” button. After 
editing a Question, User can update the question by clicking the “Update” 
Button.  
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Users can update the questions and then click the “Update” button to 
update. 

 

Importing Questions: Users can import any Question either form 
Activities or from CSV Files. To import a Question from Activities, user 
clicks “Import from Activities” button. 

 

 

 

 

 

List of Activities gets listed in the left pane of the newly opened screen 
“Import Questions from Activities” screen. User selects the Activity and the 
Question/Questions. To import clicks “Next” button.  
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While importing, user gets the opportunity to Add Properties to the 
questions. 

User selects the properties of the question. And then Clicks “Import” button 
to import.  

 

 

 

 

 

QBank Filters: 

 

The QBank Filter option remains on the left pane of the QBank Screen.  

User gets the facility to select and search a question on the basis of a 
particular area of interest/ subject. There are several categories and user 
can select a required one. User also can create a “New category”.  
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Any specific area can be further segregated to reach a specific field of 
study.  

 

 

 

 

By clicking the Create Category button user can create a new category 
under a specific existing category. 

 

 

 Scope: 

 

 

 

The “Scope” pane remains on the left of the QBank Screen.  

 Mine: By Clicking “Mine”, user can access the questions set and 

prepared by him.  
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 Institution: The Institution option facilitates the user to access the 

set of questions or a question prepared by a particular group or 

Institution.  

 Global: On a Global setting, user has the facility to explore and 

find all the questions prepared and stored by every user of Xorro-Q.  

 

 

Search: 

 

 

 

 

 

The Search option of QBank helps to find or search a question of specific 
area of interest. User types in a subject or area of interest and clicks the 
“Search” button to retrieve questions related to the area.  

 

 

 

 

Delete: To delete a question, user needs to select the question by clicking 
check box located on the left of every question. Next, User clicks the delete 
button to delete. 
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 Dashboard, My Profile and Reports 

 

 

 

 

Dashboard: A dashboard provides an overview of the participants and 
facilitators. A facilitator can get details about performance of the 
participants from the reports of dashboard. Xorro-Q’s dashboard helps any 
user to get graphical representations of output from different activities 
launched. A dashboard also necessary as it facilitates several projections 
essentially required by the facilitator to know a specific set of students/ 
class or group better. With the dashboards it is possible to identify “Poor 
Attendance” and “Low Participation”.  

 

 

 

User selects the “Profile” option from upper right section of the “Xorro-Q” 
Home page. By clicking the “ Profile”, User reaches the Dashboard Page.  

 

 

 Question Impressions:  

Xorro-Q helps in understanding performance of different facilitators 
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and students.  

Example:  Activities can be both “Real-Time” and “Self-Paced”. 
There may be group of questions and group of batches or classes.  

Let, there may be 50 faculties and 60 courses (groups) 

Let, teacher A of a course runs 2 activities.  

Let, One activity with 12 Questions and another with 8 Questions.  

Let us consider that 40 students are attending the first Activity, 
then Question impression is 40*12=480 

If, Number of received answers = 350, then Percentage of 
participation= 73% 

 

 A student is considered “participating” if he/she answers 20% of 

the questions asked.  

 A student is considered “engaged” if he/she attends 80% of the 

questions asked.  

 

Dashboard of Xorro-Q provides details of Question impressions and 
information on Participations with graphical representation.  

 

 

 

 

 

Question Impression is graphical representation of a ratio of participation 
from groups. Impression of answers over questions provides a broader 
idea of response from a specific class or group.  
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 Participation by group: Group wise participation in the Activities 

(over a period of time) gets reflected in the “Participation By Group” 

diagram. Information like Number of Questions Asked, Percentage 

of Participation and group size are also populated.  

Participant Ratio: Total number of Questions/ Total Answers  

 

 

 

 

 Impressions per participant: 

 

 

 

Individual performance of a participant can be seen from “Impressions per 
Participant” section.  This report can be found basing upon performance 
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over weeks.  

  

Reports: By Clicking the “Profile” option user reaches “My Reports” page.  

User can view reports on monthly and weekly basis by making appropriate 
selections.  

 

 

 

 

 

 

 

User identifies “Poor Attendants” and “Low Participants” by clicking the 
respective View buttons.  
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A report displays the number of sessions each attendants have logged in to 
attend. 

 

My Profile: By clicking the “Profile” option user reaches the “My Profile” 
page. Then by Clicking the “Edit User” and “Edit Interest” buttons user can 
make the changes and customise personal the profile as per personal 
preferences. 

 

 

 

 

 

 

 



Page P a g e  | 137 

 
 

 

11. Extra Workbook features 

11.1. Text conversion 

Text conversion functionality provides Workbook users with the ability to insert 
written text onto the canvas.  

Using the pen tool users insert written text onto the canvas.  Users then select the 
text using the select tool (refer to ‘Mode select toolbar’), open up the ‘object menu’ and 
highlight ‘select word’.  Workbook then lists a range of possible words and the user 
selects their word from the list.  The written ink is then converted into text.  

 

11.2. Ink into object as text 

Workbook provides users with the ability to easily insert words created using the pen 
tool (refer to ‘Mode select toolbar’) into an object as text. 

Users must first create/insert the object onto the Workbook canvas.  Users then 
select the pen tool (refer to ‘Mode select toolbar’) and begin to insert the word(s), that they 
want to insert into the object, onto the canvas.   

1 2 

1 2 

3 
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Users must then right click on the object and select the text conversion tool in the 
object menu and select the word from the list.  

 

Once the word is selected it will be inserted into the object and can be manipulated 
by using the ‘label’ tools in the object menu.  

  

3 
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12. Administrators Guide 

12.1. About Workbook  

12.1.1 System Requirements  

 Processor: 800 Mhz or greater 

 RAM: 256Mb 

 Hard Drive Space: 40 MB 

 Operating System: Windows XP (SP3), Vista (SP2), Windows 7, 8, 10 

 Microsoft.Net Framework version 4  

Workbook contains some features that take advantage of Windows 7, 
Windows 8 and Windows 10 improved touch abilities.  For this reason some 
features will not be available on older versions of Windows. 

12.1.2 Default file locations 

A user’s settings are stored in ini files located in: 

 %appdata%\2Touch\  

Default ini files can be added to: 

 %ALLUSERSPROFILE%\2 Touch Ltd\Workbook\  

Default ini files will be picked up by new users on a computer. See section 3.1 
for details. 

12.2. Deploying Workbook on a network 

12.2.1 Deploying workbook using group policy application deployment 

Workbook can be deployed using the MSI installer. A MSI transform can be 
used to set the customer key and when combined with using the group policy 
setting allowing silent activation (see section 4.2) no user intervention is 
required.  

Creating a transform 

You can create a transform (.mst) using a program such as Microsoft Orca. 
One property called KEY needs to be created and its value set to your 
customer key in the format 1234-1234-1234-1234 . 

Open the Workbook installer with Orca (tested using Workbook 2.1.0.44) 

In the Transform menu, select New Transform 

In the Property table, add a new row: 

Property: KEY 
Value: 1234-1234-1234-1234 (example) 

In the Transform menu, select Generate Transform... to save the transform 
file. 
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To test it outside of the deployment you can use a command similar to this 
(Must be from a command prompt launched as an administrator): 

msiexec /i Workbook-2.1.0.44.msi TRANSFORMS=MyTransformFile.mst 
/qn /L* log.txt 

12.2.2 Deploying Workbook in an image 

Workbook can be installed on a machine image used in your deployments. 
Install workbook, making sure to use your customer key during the install. Do 
not run workbook on the image as this will start the 30 day activation period. 
Because of this it is best to test the install on a deployed test image. Each 
computer the image is applied to will need to activate within 30 days and this 
can be automated using the group policy setting (see section …..) 

12.3. Customising Workbook 

12.3.1 Applying customised settings to all users 

Custom toolbars and settings are stored in ini files for each user on a 
computer. Customised ini files can be used as the default for all new users on 
a computer. This will not overwrite the ini files of users who have already run 
Workbook to preserve that user’s existing customisations.  

First, prepare the customized toolbars and settings in Workbook and when 
finished close Workbook.  

Copy the customized .ini file from: %appdata%\2Touch\  

Now you can copy that file to all required computers:   

%ALLUSERSPROFILE%\2 Touch Ltd\Workbook\  

For Workbook 1.2.3 and below:%ProgramFiles\2Touch Workbook\   

Workbook uses the ini files in the current user’s %appdata%\2Touch\ folder. 
If there are no ini files in that folder yet, Workbook will look for them in the 
above locations and copy this to the current 
users %appdata%\2Touch\ folder. 

That means your personalized settings will be the default for all users who 
haven’t already run workbook. If you want to overwrite an existing user’s 
settings, you will need to replace the ini files in each 
user’s %appdata%\2Touch\ folder (losing any customisations each user has 
made).  

12.4. Group Policy Settings 

12.4.1 Templates 

The group policies are available for either Windows Sever 2008 (.admx) or 
Windows Server 2003 and earlier (.adm). The templates can be applied to 
either computers and/or users. The templates can be downloaded from 
http://update.xorro.com 

http://update.xorro.com/
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12.4.2 Settings 

Checking for updates 

You can enforce how Workbook checks for updates. The options are: 

 Disable checking for updates. 

 Manual checking only (Tools -> Check for updates). 

 Check for updates at start-up. 

Allow silent activation 

This allows workbook to attempt to activate without user intervention. 
Workbook will only notify the user if activation failed with an error during 
activation or a connection to the activation server had not yet been achieved 
within the first 20 days of the trial. The default behaviour is to prompt the 
user to initiate activation. 

Prohibit saving of proxy credentials 

This prevents a user from saving their proxy server credentials when 
Workbook encounters a proxy server requiring authentication. Workbook uses 
the system proxy settings.   

 


